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Part 1;: NCS Overview

Part 1: NCS Overview

This section describes the NCS architecture and how to install and start the NCS system. It includes the following sections:
System Introduction, System Requirements, Installation, Getting Started with the NCS System, and NCS Client Overview.
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System Introduction

System Introduction

The NUUO Central Management System (NCS) is a powerful system which brings traditional central management systems
out of the control room through Internet access. The network-based key operation system can manage unlimited combinations
of analog and network cameras worldwide, via unlimited working stations in different locations. NCS is the universal solution
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Client/Server Architecture

The NCS System uses client/server architecture to manage unlimited recording systems. These send events to the NCS
Alarm Server. After filtering the events, the NCS Alarm server sends alarm logs of pre-determined events to a SQL Server
(SQL database) and NCS Client systems. The NCS Client system allows users in different locations to log in to the NCS
Alarm server and, if they have the authority, to change the system configuration. The NCS Matrix system can be viewed
as an extension of the NCS client used to populate the alarms to additional monitors. NCS Matrix system is controlled by
NCS Client users.

- &0

SGL Server ' Alarm Server

—
NCS Matrix ...=

el e e Eia

NCS Client
Definition of Terms:
Terms Descriptions
NCS System All components of NUUO Central Management system.

Recording Server  Front end servers of the NUUO Central Management system, consisting of NUUO Video
Recording systems which send events to NCS Alarm Server.

SQL Server Database of NUUO Central Management system, which backs up alarm logs.

NCS Alarm Server Alarm Server of NUUO Central Management system, which filters events in order to send
out alarms, and saves configuration of NCS system. Abbreviate NCS Server or Alarm
Server.

NCS Client Client end software of NUUO Central Management system, which is used to log in to the
Alarm Server.

NCS Matrix Video Matrix to view live video, controlled by NCS Client.

Page -5
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System Requirements

System Requirements

System Setup

There are three scenarios for NCS system setup. Depending on customers’ budget and the size of the project, customers
can choose a suitable scenario. The system requirements for each scenario are detailed below.

Scenario A: Using one PC for all installed elements

NC$S NCS NCS SaL
Client Matrix Server Server

" pe1

Recommended hardware specification for Scenario A

PC1
CPU Intel Core 2 Quad Q9550 @ 2830MHz
RAM 2GB
Hard Disk 250 GB or above

Intel 945 or 965 chip (for single monitor)

Mother-board Intel P35/975 chip or nVidia nForce 650i chip (for multiple monitors)

Display ATi X4350 or above, nVIDIA GeForce 9500series or above
Ethernet 100 baseT or above, Gigabit LAN recommended
0S MS Windows XP Pro SP3 / Vista / 2003 / Win 7 / 2008 R2

Scenario B: Using three PCs with NCS Client and NCS Matrix on PC1, NCS Server and SQL Server on PC2, and NCS
Matrix on PC3

NCS NCS NCS SQL NCS
Client Matrix Server Server Matrix

2 B B 5 8

' PC1 -7/ Pc2 -7/ PC3

Recommended hardware specification for Scenario B

PC1 PC2 PC3
CPU Intel Core 2 Quad Q6660 @ Intel Core 2 Duo Intel Core 2 Quad Q6660
2400MHz E4500 @ 2400MHz
RAM 2GB 2GB 2GB
Hard Disk 250 GB or above 250 GB or above 250 GB or above
Display ATi X4350 or above ATi X1600 or above ATi X4350 or above

Intel 945 or 965 chip (for single monitor)

Mother-board Intel P35/975 chip or nVidia nForce 650i chip (for multiple monitors)

Ethernet 100 baseT or above, Gigabit LAN recommended

os MS Windows XP Pro SP3 / Vista / 2003 / Win 7 / 2008 R2
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Scenario C: Using four PCs with NCS Client and NCS Matrix on PC1, NCS Server on PC2, SQL Server on PC3, and NCS
Matrix on PC4

NCS NCS NCS sSqL NCS
Client Matrix Server Server Matrix

BB B B B

PC1 PC2 ‘ PC3 PC4

Recommended hardware specification for Scenario C

PC1 PC2 PC3 PC4
CPU Intel Core 2 Quad Intel Core 2 Duo Intel Core 2 Duo Intel Core 2 Quad
Q6660 @ 2400MHz E4500 E4500 Q6660 @ 2400MHz
RAM 2GB 1GB 1GB 2GB
Hard Disk 250 GB or above 250 GB or above 250 GB or above 250 GB or above
Display ATi X4350 or above | ATi X1600 or above | ATi X1600 or above | ATi X4350 or above

Intel 945 or 965 chip (for single monitor)

Mother-board Intel P35/975 chip or nVidia nForce 650i chip (for multiple monitors)

Ethernet 100 baseT or above, Gigabit LAN recommended

os MS Windows XP Pro SP3 / Vista / 2003 / Win 7 / 2008 R2

Multiple Monitor Configuration

For a PC running the NCS Client and NCS Matrix, it is suggested that three monitors are used: one to display the Map
window and the System Configuration window, one to display the Alarm Overview window, and one to display the live
video feed matrix. This enables efficient use of the system and saves hardware costs.

PCs using multiple monitors in this way should have a Intel P35/i975x motherboard which can support two display cards.
Each display card should be the same model, to avoid hardware conflicts.
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Installation

Installation

The NCS Installation CD contains the software you need to run the complete NCS system. If you are installing the system
on multiple PCs as described earlier, install the appropriate software for each PC:

. For the PC running SQL Server, install SQL Server 2005 Express.
. For the central server PC, install NCS Server
. For client PCs, install NCS Client

. For PCs displaying video matrixes, install NCS Matrix.

The following sections describe installation of each element of the NCS system.

SQL Server 2005 Express

To install SQL Server 2005 Express:
1. Insert the NCS installation CD.

Central Management

SQL S 2005 E
Software | 13 ferver 2005 Expres
NCS Server
NCS Client

NCS Matrix

User Manval

2. Inthe Welcome to NCS window, click SQL Server 2005 Express.

If you do not have Microsoft .Net Framework 2.0 and Windows Installer 3.1 installed, a message will
appear. Download and install the application from the link in the message or from the toolbox directory of
installed CD.

Lol Microsoft SOL Server 2005 Setup

End User License Agreement

MICROSOFT SOFTWARE LICENSE TERMS [
MICROSOFT SQL SERYER 2005 EXPRESS EDITION SERYICE PACK 2
These license terms are an agreement between Microsoft
Carparation (or based on where you live, one of its affiliates) and
you. Flease read them, They apply to the software named above,
which includes the media on which you received it, if any. The
terms also apply to any Microsoft

* updates,

* supplerments,

* Internet-based services, and

¥ [asemmi s e e s s

Print Next > Cancel

3. Inthe End User License Agreement dialog box, read the terms, check | accept the licensing terms and
conditions, and then click Next.
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Installation

el Microsoft SOL Server 2005 Setup L Microsoft SOL Server 2005 Setup

&

Installing Prerequisites Installing Prerequisites
Ietalls software companents required prior to instaling SAL Installs software companents required prio to instaling SAL
Server. > Server.

SOL Server Component Update will install the following components S0OL Server Component Update wil install the following cormponents
required for SOL Server Setup: required for SQL Server Setup:

Micrasoft SOL Native Client

¥ Microsoft SQL Mative Client
Microsoft SQL Server 2005 Setup Support Files

+ Micrasaft SQL Server 2005 Setup Suppart Flies

Click Install to continue. The required components were installed successfully

[ [

4. Inthe Installing Prerequisites dialog box, click Install to continue update, and then click Next to continue

installation.

ﬁ! Microsoft SOL Server 2005 Setup

» Welcome to the Microsoft SQL
Server Installation Wizard

Setup will help vou instal, modity or remove Microsoft
S0L Server. To continue. click Next

< Back I Next > I Concel |

5. Inthe Welcome to the Microsoft SQL Server Installation Wizard dialog box, click Next to install.

ﬁ! Microsoft SOL Server 2005 Setup E

System Configuration Check
Wait while the system is checked for potential installation

pioblens.
L
13 Tatal 0 Errar

| @ Success 13 Success 0 Warming

Detas:

| Action [ Status [ Message [a]
@ Minimum Harchware Requirement Success

@ Pending Rebaot Requitement Success

@ Default Installation Path Permission Re...  Success

@ Intemet Explorer Requirement Success

@ COM Plus Catalog Reguirement Success

@ ASF.Net Version Registialion equire...  Success

@ Minimum MDAC Version lequirement  Sucoess

@ Ediion Changs Check Success

Flter  w Siop Repot v
Help:

6. Inthe System Configuration Check dialog box, click Next.

72 Microsaft SOL Server 2005 Express Edition Setup

E

Registration Information
The following information will personalize your installation,

The Name field must be Filed in prior to proceeding. The Company field is optional,

Mame:
[Mira

Company:
[P

[ [ e e v —— ]

Help < Back [ met= [ cancel

7. In the Registration Information dialog box, enter your name and company, and then click Next.
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Installation

15! Microsoft SOL Server 2005 Express Edition Setup

Feature Selection
Select the program features you want installed.

Click an icon in the Following list to change how a feature is installed
Feature description
Installs the SOL Server Database

-EE iDatabase Services
= - Engine, tools For managing relational

3~ Connectivity Components and KML data, and replication
&3~ | Software Development kit

This feature requires 67 MB on your
hard drive. It has 3 of 3 subfeatures
selected, The subfeatures require 119
MB an your hard drive.

Instalation path

Ci\Program Files|Microsoft QL Server),
Disk Cost. .

[ <pack  J[ pest= I[ Cancel |

8. Inthe Feature Selection dialog box, select Database Services, and then click Next.

ﬁMicrusuf( SOL Server 2005 Express Edition Setup

Authentication Mode
The authentication mode specifies the security used when
connecting to SCL Server.

Select the authentication mode to use For this installation,

() wfindows Authentication Made:

I (© Mixed Made (Windows Authentication and SGL Server Authentication) l

Specify the salogen passward belon:

Enter password:

[

Confirm password:

[fen]

[ <pack  J[ west> J[  concel |

9. Inthe Authentication Mode dialog box, enable Mixed Mode option, and then enter and confirm a password.

15 Microsoft SOL Server 2005 Express Edition Setup

Configuration Options
Configure user and admiistrator accounts

This option enables users without administrator permissions to run a separate
instance of the SQL Server Express Database Engine,

[Cl&dd user to the SOL Server Administrator rols!

This option adds the user wha is running the SQL Server Express installation pragram
to the SOL Server System Administrator role. By default, users on Microsaft Windows
Vista aperating system are not members of the SQL Server System Administratar rolz.

BT [T (T

10. In the Configuration Options dialog box, select Enable User Instances option, and then click Next.

15! Microsoft SOL Server 2005 Express Edition Setup

Error and Usage Report Settings

Help Microsoft improve some of the SQL Server 2005 components
and services.

Automatically send Error reports For SQL Server 2005 ko Microsoft or your corporate error

[J1portin server. Ervor reports inchyde information regarding the: condition of QL Server
2005 when an error occurred, your hardware configuration and other data, Errar reports
may unintentionally include personal information, which wil not be used by Microsoft.,

{Autamatically send Eeatire Lisage data for SQL Server 2005 to Microsoft, Usage dats
fincludes anonymous information about your hardware configuration and how you use our
Software and services

By installng Microsoft SGL Server 2008, 5oL Server and its components wil be configured ko
automatically send Fatal service error reports to Microsoft o a Corporate Error Reparting
Sepver, Microsoft Uses srror reports ko improwe SQL Server functionality, and treats al
infarmation as confidential.

e

bext> || Cancel |

11. In the Error and Usage Report Settings dialog box, you do not need to select any option. Click Next.

Page - 10
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Installation

15 Microsoft SOL Server 2005 Express Edition Setup

Ready to Install
Sebup is ready to begin installation,
B> |

Setup has enough information ko start copying the program Files. To proceed, click Install. To
change any of your installation settings, dick Back, To exit setup, dick Cancel.

Trhe following components will be installed:

- SOL Server Database Services
(Datzhase Services, Replication)

The following components that you selected will not be
changed:

. Client Components

< Back. ]I Install I[ Cancel

12. In the Ready to install dialog box, click Install.

Ll Microsoft SOL Server 2005 Setup

Setup Progress
The selected campanents are heing configured

Product | Status
(s Setup Finished
(501 Setup Support Files Setup finished
(5oL Native Cliert Setup Frished
(Z50L Y55 Writer Setup finished
(501 Server Database Services Setup finished

<= Back concell |

13. In the Setup Progress dialog box, wait for installation finish, and then click Next.

Ll Microsoft SOL Server 2005 Setup

Completing Microsoft SQL Server 2005 Setup
Setup has Frished configurtion af Micrasoft SQL Server 2005

Refer to the setup error logs for information describing any Failure(s) that occurred during
setup, Click Finish ko exit the installation wizard.

Summary Log
To minimize the server surface area of SQL Server 2005, some Features and services are

disabled by default for new installations. To corfigure the surface area of SGL Server, use the

surface Ares Configuration taol,

Configuring and Managing SQL Server

Express

+  Forimproved manageability and security, SGL
Server 2005 provides more control over the SOL
Server surace area onyour system. Ta minimize
the surface area, the fallowing default
configurations have been spplied to your
instance of SOL server.

o TCPAP connections are disabled

R I Ere ||

- [NPy=Y

14. In the Completing Microsoft SQL Server 2005 Setup dialog box, click Finish

NCS Server

To install NCS Alarm Server:
1. Insert the NCS installation CD.

Page - 11
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Installation

Central Management

Software SQL Server 2005 Express

For Central Server PC

NCS Server |

NCS Client

NCS Matrix

User Manual

2. Inthe Welcome to NCS window, click NCS Server.

NUUO Central Management Server - InstallShield Wizard %]

‘Welcome to the InstallShield Wizard for NUUO
Central Management Server

The InstaliShield wizard will install NUUO Central
Maniagemert Server an pour computer. To continue, click
Next.

3. Inthe InstallShield Wizard dialog box, click Next to continue.

NUUOQ Central Management Server - InstallShield Wizard

License Agreement

Please read the following license agreement carehilly.

End User License Agreemert ("ELLA")

[

Do not install or use the software until you have read and accepted dll of the license
erms. Permission to use the software is condifional upon your agresing to the license
terms. Installetion or use of the software by you willbe desmed to be acceptance of
the license terms. Acceptance will kind you 10 the license terms in a legally enforcesble
(contract with NULO Inc

* SOFTWARE LICENSE AND LIMITED YYARRANT Y
This is an agreement between you, the end user, and NUUO nc. ("MULO™. By using

this software, you aoree to become bound by the terms of this agresment |

i zccept the isms of the licenss agresment l [ em ]

(L)1 do rot accept the terms of the license agieement

[ <Back | Hest> J [ Cancel |

4. In the License Agreement window, read the terms, select | accept the terms of the license agreement, and
then click Next.

NUUOQ Central Management Server - InstallShield Wizard

Customer Information

Please enter your information

Please enter yaur name and the name of the campany far which you wark,

User Name:

nuug|

Company Name:

NUUD

[ <Back J| Mest> J [ cancel |

5. In the Customer Information window, enter your name and company, and then click Next.
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NUUO Central Management Server - InstallShield Wizard El

Setup Type
Select the setup type to install

Please select a setup type.

All program features will be installed, [Requires the most disk space.]

) Custom
Select which program features you want installed, Recommended for
advanced ussis.

IristalShield

[ <Back J[ Mew> | Cancel

6. Inthe Setup Type window, select Complete, and then click Next.

NUUO Central Management Server - InstallShield Wizard E}

Ready to Install the Program
The wizaid is ready to begin installation.

Click Inztall to begin the instalatior.

IF you want 1o review or change any of your installation settings, click Back. Click Cancel to exit
the wizard

IristalShield

¢ Back Instal Cancel

7. In the InstallShield Wizard window, click Next.

Question X

:" SGL Hative Client s the necessary component to run NCS Server,
:

Wold you ke to install now (recommended)?

8. Please click Yes to install SQL Native Client program.

NUUOQ Central Management Server - InstallShield Wizard

InstallShield Wizard Complete

The InstallShield ‘wizard has successfully installed NULIO
Central Management Server. Click Fivish to exit the wizard,

< Back | Cancel

9. Inthe InstallShield Wizard Complete dialog box, click Finish.

NCS Client

To install NCS Client (include Matrix):
1. Insert the NCS installation CD.

Page - 13
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Installation

Central Management

Software SQL Server 2005 Express

NCS Server

NCS Client

For Client PC (Including NCS Matrix)

NCS Matrix

User Manual

2. Inthe Welcome to NCS window, click NCS Client.

NUUO Central Management Client - InstallShield Wizard

‘Welcome to the InstallShield Wizard for NUUO
Central Management Client

The InstallShield wizard will install NULUID Central
Management Client on your computer. To continue, click
Next.

3. Complete installation as described in steps 3-7 of the To install NCS Alarm Server section on page 11.

NUUQ Central Management Client - InstallShield Wizard

InstallShield Wizard Complete

The InstallShield ‘wizard has successfully installed NUUIO
Central Management Client. Click Finish to exit the wizard

—

4. Inthe InstallShield Wizard Complete dialog box, click Finish.

NCS Matrix

To install NCS Matrix:
1. Insert the NCS installation CD.

Central Management

Software SQL Server 2005 Express
NCS Server

NCS Client
NCS Matrix
For Malrix PC

User Manval

2. Inthe Welcome to NCS window, click NCS Matrix.

3. Complete installation as described in steps 3-4 of the To install NCS Client section on page 13.
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Uninstalling NCS System

To uninstall SQL Server:

Installation

In the Control Panel, open Add or Remove Programs, select and click on Remove button to uninstall four SQL objects
(Microsoft SQL Sever 2005, Native Client, Setup Support Files, VSS Writer).

‘.3 Add or Remove Programs E]@
=
Eﬁ Currently installed programs: [ show updates Sort by | ame v
Cpanesor || Micrasoft SOL Server 2005 el 1]
Programs Click here for support information. Used rarely
Last Used On 2008/2j25
i ! Ta change this program of remave it from yaur computer, dick Change ar Remaove,
Add New
Programs 5 Microscft SQL Server Native Cliant Size  4.00MB
e 5 Microsoft SQL Server Setup Suppart Files (English) Siee  21,92MB
:;] [ Microsaft SCL Server W53 Wriker Size  0.67ME
Windows 59 Micrasaft User-Mode Driver Framework Feature Pack 1.0

To uninstall the NCS system:

In the Start menu, point to All programs, point to NUUO Central Management Server/Client/Matrix, and then click

Uninstall NCS System.

@ Transfer all license connections and then transfer license base before you uninstall the NCS System.
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Getting Started with the NCS System

Main Console Configuration

To configure the Main Console:

1.

5.
6.

Run MainConsole.exe.

Network Service - 192.168.1.84 /0.0.0.0

Main | Black fwhite List | Performance |
Live Client Count o Kill Client Kill All Clients

Bitrate (Kbps)

State IF Camera

@ Semice
Server Status: Running
Remote

Cptions

Central
Maragement i1

75 (%]

In Config, select Network Service, and set up the following services:

* Live Streaming and Central Management. These services are essential to run the NCS system. Please start
these two services.

* Remote Playback. This service enables recorded video viewing and remote playback. This service is also
responsible for providing data for client backup. Ensure this service works, please also Start Recording
Schedule to record video.

* Remote Desktop. This service enables remote configuration of the main console.

Select Guard.

" Event and Action Configuration

Event Action

[>T o &l & | a

=144k CAMOZ camera 1 Action Options
&, General Motion Bdsend to Central Server

[ Digital Input
#] system

Video Preview

ﬂ‘.r-
J -

In the Event and Action Configuration window, configure alarm events and insert the action Send to Central
Server for events that you want to appear on the NCS system.

Click OK to return to the main console.

In the Start Menu, select Start Smart Guard System to start detecting events.

SQL Server

To configure SQL Server:

1.

In the Start menu, point to All programs, point to Microsoft SQL Server 2005, point to Configuration Tools, and
then select SQL Server Configuration Manager.
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@ SOL Server Configuration Manager

| Fle Action View Help
&= SR
S0l Server Corfiguration Manager (Locsl) | ProtocolMame | Status [
B 5L Server 2005 Services - shared Hemory | Enabled

= et D ML O OO UL W MamedPipes  Disabled
[ Pratacols for cMALARMLOG
-5 T ST

]

¥ TCP/P Dissbled
A Disabled | ENeble

Properties

Help

2. Inthe SQL Server Configuration Manager window, select Protocols for CMALARMLOG, right-click TCP/IP and
then select Enable to enable TCP/IP protocol.

TCP/IP Praperties
Protocol | TP Addresses
=
Active Ves
Enabled Mo
1P Address 192,168,184
TP Dynamic Part g
| TcP Port 1433
|
Bctive Ves
Enabled o
1P Address 127.0.0.1
TCP Dynamic Ports 0
| TcPPort 1433
B
TCP Dynamic Ports o
[Trerpor: L4
TCP Port
TCP port
[ oc  J[ cacel J[ sy J[ meb |

3. Double-click TCP/IP, then in the TCP/IP Properties window select the IP Addresses tab.
4. Enter 1433 as the TCP port in IP1, IP2, and IPAII, and then click OK.

L SOL Server Configuration Manager
File  Action  View Help
= = B 0 wmEe
? L ™ Loca) | Mame [ State [ startm... [Log
ﬁ 5L Server 2005 Services l 5)50L Server (CMALARMLOG) Runni
'gEF Protocols for CMALARMLOG . serverBrowser SRR shop
-2 SQL Native Client Configuration Pause
Restart
Properties
Help

5. Inthe SQL Server Configuration Manager window, select SQL Server 2005 Services, right-click SQL Server
(CMALARMLOG), and then select Restart.

6. Ensure that any firewall allows access through port 1433.

NCS Alarm Server

To configure NCS Server:

1. In the Start menu, point to All programs, point to NUUO Central Management Server, and then select NCS Server.

NCS Server

. | ) Please specify the SQL server and sa password you want ko connect to,

2. Inthe NCS Server dialog box, click OK. This is only required the first time you start NCS server.
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NCS Alarm Server {License: 48-8-2 - Trial 30 Days) o
Main Cnnﬂguratmnlaagkuﬂ
SQL Server
Status (local) - Connected
Server. [ocan =
Pagsword for sa: "“”
Connect
NCE Configuration
Save, Load and Resetthe all the central management configurations, including
s8IVErs, Maps , users, alarms and so on
Save Load Reset NCS Configuration

Options

Alarm Image Path
I CAProgram FilesiNUUOWNCS_ServerlCMSEventimages F‘nﬂm

I~ SQL Reconnection

[~ Run NCS Serverwhen windows starftup

= % cance

3. The configuration of NCS Alarm Server.

* In the Configuration tab of Central Server window, enter the IP address of the SQL Server, and then enter and
confirm the password set when installing SQL Server. (see page 10)

* Specify a URL at which to store all alarm images.

* Select Run NCS Server when Windows starts up if you want NCS Server to startup automatically at Windows
startup

4. In the Main table of this window, check the server has been Start and click OK.

Q The NCS Server must be executed before the NCS Client can be executed.

NCS Client

To configure and execute the NCS Client:
1. In the Start menu, point to All Programs, point to NUUO Central Management Client, and then select NCS Client.

nuuo SECURITY

Central Login

CRYSTAL EOJRD

Severlr; 16216811 Port; 5180

Usemame: admin

Fassward

v 0K X Cancel

2. Inthe Central Login window, enter the IP address and port of the NCS Server PC. The default port is 5180.
3. Enter a user name and, if required, a password. The default user name is admin and the default password is
empty.
4. Click OK.
To activate software license key(s)
1. Open License Manager Tool in Help menu.
2. Select Activate tab, check the NCS system in On line network environment.
3. Insert the SN, SN file or dongle to activate license.
4

After software license is activated successfully, please restart NCS Client.

Q) Please refer to page 55 for advanced settings.
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To start up NCS Client automatically:
1. In the Edit menu, select NCS Client Setting.

[+ Enanle Auo Starlug

[ Enanle Autn Login

User Account a0min
Password ik
Password Confirm [

v 0K X Cancsl

2. Inthe NCS Client Setting window, select Enable Auto Startup and Enable Auto Login
3. Enter a user account and, if required, a password.

4. Click OK.

e Please refer to page 24 for advanced settings.

NCS Matrix

To execute a single matrix display:
1. In the Start menu, point to All Programs, then point to NUUO Central Management Client or NUUO Central
Management Matrix, and click NCS Matrix.
To configure the first matrix in a multiple matrix system:
2. Ensure that the PC is configured to use multiple monitors.

3. Inthe Start menu, point to All Programs, then point to NUUO Central Management Client or NUUO Central
Management Matrix, and click NCS Matrix.

Matrix Instance Dialog
Instance Name: | Default <
Dption. ~  Stat ‘ X Cancel |

4. Click on Option to open Matrix Instance Dialog.

Matrix Instance Option Dialog

Instance Name: | Default
Matrix Server Part: |5210 Default
Display Wonitor.  |#1 (1280 800 i

Add ‘ Delete ‘ I Update: I

Mame Port Wanitor
‘Default 5210 1

« Ok X Cancel

5. In the Matrix Instance Option Dialog window, select Default from list table.
6. Enter a matrix name, for example Monitor 1, in the Instance Name text box, leave the port at the default setting of
5210, select the #1 monitor from drop-down list, and then click Update to update maodification.
To configure the second and subsequent matrixes in a multiple matrix system:

1. In the Matrix Instance Option Dialog window, enter a matrix name, for example monitor 2 in the Instance Name
text box.

2. Enter port number 5220.

3. Select the #2 monitor from drop-down list, and then click Update to update modification.
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Matrix Instance Option Dialog

Instance Name IMnmtnrQ

Miatrix Server Port: (5220 Default
Display Monitor: #2(1280x1024) -

aod | | |

MName ‘ Port ‘ Monitor ‘
Manitor 1 5210 1
RGO e

v Ok X Cancel

4. To configure a third and a fourth monitor, repeat steps 1-3 naming the matrix instances as appropriate (for
example monitor3, monitor4), entering the port number (5230 for a third monitor and 5240 for a fourth), and
selecting the appropriate monitor.

5. Click OK to save all configuration of Matrix.

To execute a matrix in a multiple matrix system:

1. Ensure that the matrixes have been configured as described above.

Matrix Instance Dialog

Instance Mame: | Matrix 1 &
Matrix 1
‘ Matrix 2 _

Option

2. Inthe Matrix Instance Dialog window, choose the matrix you want in the drop-down list, and then click Start to
start Matrix view.

3. Repeat steps 1 and 2 to execute each monitor.
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NCS System Overview

NCS Server Window Introduction

The NCS Server features four main tab windows, including :

The Main window controls the start/stop NCS server as well as the client connection through kill client/kill client all

options.

Under the Configuration window you may setup the connection between SQL Server and NCS Server,.

KCS Alarm Server =) NCS Alarm Server =)
Main WCnnﬂguralmnl Backup} License Status Main  Configuration WBaEkupl License Stalusl
Glient Gount 1 el BEIRED
Status {localy - Connected
State P
RuMMIng 192,168,168 Server. |(m:a|) j
Password for sa: |”"*
MNCS Configuration
Save, Load and Resetthe all the central management configurations, including
Kill Cliertt ] [ Kill & Clients ] servers, maps , users, alarms and o on.
Serice
Reset NCS Configuration
Server Status: Running
Options
aptions
Alarm Image Path:
EPragram Files\CMSEventimages (SRS
I~ SaL Reconnection
[ Run NCS Serverwhen windows startup

f@ﬁ Restoring NCS Configuration will not clear the setting of SQL Server.

NCS Server enables backing up alarm records at a local hard drive or to FTP servers. Define a storage location for

video backups under the Backup window.

You may select between two storage locations. Choose Disk Storage for local hard drives or DAS, or choose FTP to

backup to FTP servers.

The License Status window displays current available licenses in the system.

HCS Alarm Server =) NCS Alarm Server =)
Main | Configuration Backup | License Status Main | Gonfiguration | Backup License Status
Backup Lacation License Status
(" Disk Storage License Status: Trial 13 days remaining)
License Type Camera | 110 POS AC LPR
Total License 18 ] 1 H 1
& FTP
Sener |
Fort [21 Defait
User Account [
Passward |
Backup Directary |/
Upload Test Fiie
- E—
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By double clicking on the server icon from the Taskbar you can access NCS Server settings directly.

You can also check the version of your system or stop the service by right clicking on the icon and clicking About or
Exit.

About NCS Alarm Server

MCE Alarm Server Wersion 1.5.0

Copyright (C) 2004-10

NCS Client Window Introduction

The default NCS Client window placement is as the following figure, including three main windows, four toolbars, and six
menus.

= NCS Client [admin] [Trial] n =Iolx
File Edit View Tools Zoom Help —lvVienus
SlEd @
-
ZEdit Mode Toolbox
y-y-N

K688 ED S| 4 ==

“1ServerGroup

System ||| Alarm
Control ||Overview
Window [||Window

caplnumscrL]

s, [@m, [#c.[am] | or SR|E0mO|T
Ready

Three Main Windows are:

o System Control window: This window includes the Server List, Map List, Configuration, Matrix List and View
Group List sub-windows. Administrators can configure the NCS system in this window when the system is in Edit
Mode. (See Part 2: Administrator Functions (Setting Up the NCS System)

Servertiew * o X

= [ ServerGroup
=) MU Inc
(=& NUUS Taivwan

% demal1)

3 dema(2)

2 demal3)

E demal4)

;/ demai1}-Input 0
<7 demaf1)-Input 1
;/ demof1)-Input 2
;} demof1)-Input 5
I demaf1)-Output 0
I demal1)-Output 1
U\ demol13-Cutput 2
1 demaf13-Output 3
;/ demoi1}-Input 0
<7 demal2)-Input O
;/ demofZ3-Input 1
1 demaf13-Output 0
1 demaf1)-Output 1
I demal2)-Output 0
U\ demal2)-Output 1

-Q%Server... ﬁ?Canig... EMatrixV...@Map\u‘iew
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Map window: This window shows all maps and device indicators. For administrator setup, see page 30. For day to
day use, user can view the video, show device information, query and manage alarms from the indicators (please
refer page 70).

Alarm Overview window: The default Alarm Overview window contains the Recent, Real-Time, Output, Output 2,
and Message Log tabs, which allow users to manage alarms (see page 61).

IR

v e e e
KL A Te ot WA Taben et TAAD T il

v [ et S| Dovks Disienton

Six menus are:

The File menu: This menu has functions use to commit to NCS Server, save/load NCS Client Configuration, and
Logout/Exit NCS system.

The Edit menu: It allows administrator add New Object to configuration sub-window of System Control Window,
Import Indicator Image, setup Server configuration (refer Central Server Configuration Window section of page 42)
on Edit mode; and allows all user to setup Map Display setting of Map windows, Alarm Log setting of alarm
overview windows, and setup Joystick to control Matrix.

The View menu: This menu has options to setup the appearance of NCS Client window.

The Tools menu: This menu has five tools to help user easy to get information for Main Console, manage alarms,
and view live and record videos.

The Zoom menu: User can control and adjust map appearance (see page 70).

The Help menu: The menu provides the version information of NUUO NCS Client.

The toolbars are:

The Standard toolbar: The functions accessed by this toolbar are: toggle Edit Mode/Operate Mode (see page 26),
committing configuration changes to the server (see page 26), importing/exporting NCS Client software
configuration (see page 54), and displaying version information (see page 92).

The Map toolbar: The functions accessed by this toolbar are used to adjust map appearance (see page 70).

The Operate toolbar: The functions accessed by this toolbar help users in day to day use of the NCS Client. For
more information, see page 60.

The Status toolbar: Quick links to SQL Server Status and Central Backup Status can be found here.

The Search toolbar: The functions accessed by this toolbar include functions involved in searching (see page 71).

| PEdit Mode B L5 d @*55 AL, HFligbasraol i) Bl

Standard Map Operate Status Search
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NCS Client Setting

You are able to configure functions including auto startup, auto login, auto reconnection, instant playback and client
recording under this window. Go to the Edit menu — NCS Client Setting.

NCS Clicnt Setting

Startup Record Setting

v i v Recording on the Client

Iv¥ Enahle Auto Login Fath
S SRR ,— |CaProgram FilesiCliert Recordings -
Passward Pre-Record Time: 3 Sec  (Max BO)
Passwaord Confirm Fost-Record Time: 15 Sec  (Max 120)

v Auto Recycle

IFAEEAEEE Keep Recording 180 dayis)

Iv¥ Enable Auto Reconnectto NCS Server e ey iEaring e e

[v Enable Auto Reconnectto NCS Matrix storage is less than 5 %
Instant Playback Setting Miscellaneous

Pre-Playback 5 Sec  (Max 60) Iv Show central ID on server list and matrix list
Post-Playback 15 Sec  (Max 120)

[\/ 0K ][X Cancel ]

. Startup: Check to enable auto startup or auto login.

. Reconnection: Check to enable auto reconnection to NCS Server / NCS Matrix when connection is lost.

. Record Setting: Check to enable alarm triggered local recording on NCS client. You may customize pre/post
record time and auto recycle settings.

. Instant Playback Setting: Configure pre/post playback length under instant playback windows.

. Miscellaneous: Check Show central ID on server list and matrix list to display server / device / matrix ID

number on server and matrix lists. This is mainly for Joystick control. For details, please refer to p. 87.

To enable Recording on NCS Client or instant playback you MUST also start recording from Main
Console. NCS cannot access playback if Main Console has not recorded video.

Customizing Client Appearance

The appearance of the NCS Client is customizable. The System Control and Alarm Overview windows and their nine
associated tab display windows can be moved or removed to four appearance types:

. Floating: A floating window can be moved to any position on the screen.
. Docking: A docking window is aligned with one of the four edges of the application window.
. Auto Hide: Docking windows can be set to AutoHide. The window then displays only when you point to the area

of the screen where the window is docked.
o Hide: Hide the windows can be removed from screen.

Toolbars also can be moved or removed. The outlook of the client can also be changed to various preset styles.

Q To restore appearance back to default, please go to View menu and click on Reset Window Placement.
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To move a main window:

Click the title bar at the top of the window and drag it to the position you want. If you want it to dock at one of the edges of the
NCS Client window, drag it to one of the direction arrow buttons. There are three direction arrow buttons groups of different
windows (refer next page):

. The Central group of Map Window, it allow move window to four edge of Map window.
. The Outside group of NCS Client Window, it allow move window to four edge of Map window.
. The Attached group of individual window, it allow move window to four edge of individual window and move to be
an associated tab display windows.
To move an individual tab display window:

Right-click on a tab and select Floating, or click directly on the tab and drag the window to the position you want. If you
want it to dock at one of the edges of the NCS Client window, drag it to one of the blue direction arrow buttons. The Auto
Hide function can now be applied to that tab window individually.

To move an individual tab display window to a main window:

Right-click on a tab and select Docking, or click directly on the tab and drag it to a tab bar in a main window.

[EI NCS Client fadmin] S[E=)
i Flle Edit Yew Tooks Zoom Help
| S @ i 2R Py Peditee LEF 5B BB J
Configuration vax .
" s [E}-Outside Group
dmin

sun-pey ]| wee

o m%—Attached ‘

Matris¥iew x

0L L e

Gorstessew | zindino | ndino [

Eserv.., | Bmap.. | 2 confi...

Ready

: Q These direction arrow buttons groups only appear when NCS Client preset style set as Office 2003 / Visual
“&f" | Studio.NET 2005/ Office 2007

To Auto Hide a window (only available when window is docked):
Either:

. Right-click in the window and select Auto Hide.
Or:

. In the title bar for the window, click the Auto Hide toggle button ‘.

Q The Auto Hide function applies to all tab windows in a main window. If one of the tab windows in a main
' " | window is set to Auto Hide, all the other tabs will also Auto Hide.
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To close an individual tab display window:

Right-click on a tab and select Hide or click directly on the Close Window button '# on the top right corner of the window.
To display the window again, go to the View menu, point to Toolbars, and then check the window you want to show.

'SQﬁ Another way to close a window is to uncheck a box in the Toolbars menu.
To move a toolbar:

Click on the double line on the left side of a toolbar and drag it to the position you want.

To hide or display a toolbar
Go to the View menu, point to Toolbars, and then uncheck or check the toolbar you want to hide or show. And if user drag
to as an individual menu in window, simply click the # button on the top right corner of the menu to close it.

To change the look of the NCS Client to a preset style:

In the View menu, point to Application Look, and choose one of the following preset application looks: Office 2000 / Office
XP / Office 2003 / Visual Studio.NET 2005 / Windows XP / Office 2007

System Operate Mode/Edit Mode

f@ﬁ To carry out most administrator functions, you need to be in Edit Mode.

Press the Edit Mode toggle button [#|Edit Made to enter Edit Mode, and press it again to exit Edit Mode. When in Edit

Mode, the NCS Client will not receive alarms. A flashing indicator \/, reminds you that you are in Edit Mode.

Any changes made to the system must be saved with the Commit E¥] commit. button. When administrators

A click the Commit button to save changes, other users will be disconnected from the NCS server and will
need to log in again.

NCS Matrix Window Introduction

a0

Move Mouse to right-down area, the icon would auto appear. User can edit/exit the Matrix, further option

please see page 51.

SQL Server Introduction

NCS system is use SQL Server 2005 Express of Microsoft free application software as database. NUUO recommend user
to use Microsoft SQL Server Management Studio Express to backup SQL Server. Please refer the web site of Microsoft
http://technet.microsoft.com/en-us/library/ms365247.aspx .
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Part 2: Administrator Functions (Setting Up the NCS
System)

This section describes functions and operations of the administrator to set up the NCS Client software system while in Edit
Mode. Please follow this section to setup Servers/Devices, Maps, Servers/Devices on Map, User Groups and Users,
Coverage, Alarms, and Matrix system.

27



Servers/Devices

Servers/Devices

The NCS Client provides the ability to monitor unlimited cameras and input/output devices through unlimited Main Console
servers. For convenience, Main Console servers and their related devices are organized into groups. The default top-level
group is called ServerGroup. Child groups can be added to this in a hierarchical structure.

Q To carry out the functions described below, you need to be in Edit mode and Commit after setup (see
=" |page 26).

The license of the software should be registered first before operating the formal version of NCS System.

Q Execute the License Management Tool in Help>License Manager to activate the license from a dongle or serial
é number allocated with the NCS software package, or de-activate the license then use it on another PC to activate it
again. Please refer to page 55 for details on how to configure the License Management Tool.

Adding/Editing/Removing Server Groups
To add a server group:
1. Ensure that the client is in Edit Mode and that the ServerView tab is selected.
2. Right-click on the ServerGroup icon [__]| at the top of the window, then click Add Group.
3. Enter the group name, then click OK.
4. The group you added appears in the tree structure of the ServerView window.
To edit a server group name:
1. Right-click on the server group icon | ] for the group you want to edit.
2. Select Settings.
3. Enter the name you want, then click OK.
To remove a server group:
1. Right-click on the server group icon [ ] for the server group you want to remove.

2. Select Delete and click Yes at the confirmation prompt.

Adding/Editing/Removing Servers

Servers can be added to any server group. When a server is added, the devices on it must be synchronized with the NCS
Client (See page 29). This procedure ensures that the cameras, input/output devices, and metadata devices on the server
are available for monitoring.

To add a server:
1. Ensure that the client is in Edit Mode and that the ServerView tab is selected.
2. Right-click on a server group icon [__], then click Add Server.

3. Enter the server details, then click OK. The Central Management Port should be the same as setup in Main
Console server.

4. The server you added should appear in the tree structure of the ServerView window.

To edit settings of an existing server:

1. Go to server view under Edit Mode.
2. Right-click on an existing server and choose Settings...

3. Click OK after configuration is done.
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4 Server Configuration
asit Setting
Server Name: [Local Central Manitoring Port: [5170 Detect
IF Address: |192 168.1.104 Live Streaming Port: 5150 Default
User Narne |admin Remate Playhack Port 5160
Pagsward: [ Remote Deskiop Port 5140
Server Informatian
State |Mmh|gan Add ] [ Delete I [ Edit ] [ Expart ] [ Import
City: |Detroit Contact Mame | Contact Phone | Coverage
Leonardo 0887654321 Always
Zip |123455 Daonatella 0812345678 Always
Rafael 0363852741 Always
Server Address Think Origin 12 hict ] 0987412365 Always
Account Type: Superman
Other Information:
< m | 2]
|

Q Licenses for all servers and devices (cameras, I/0O devices and metadata devices) need to be activated via
NCS Client. (See Page 56)

Q If you enter the Central Management port and click Detect, the NCS system will auto-detect the ports for
“&r" |Live Streaming, Remote Playback and Remote Desktop.

Q Click the Server Info button to open a Server Information window, and the Server Information will be
“&r" |displayed on the Alarm detail window when an alarm is active.

To add contacts to the server: —
1. Click on Add under Server Configuration. ame: Leonsro
*Phane: |DQBTES&321
2. Complete the required info and click OK. Phane Type: flanaiime
Pass Code: |as27
Permit: |225
To synchronize server devices: - [ose532147
Right-click on a server icon &4 | then click Synchronize Device. Then, all E-Mail: [leo@nuus com
cameras, metadata and input/output devices of Main Console server will Camment: General Manager
appear and be available for monitoring.
Gantac Time |Atways -
v o | [X cneal |

You must have enough licenses for the devices, otherwise the devices without licenses will show disable

fQZ icon&. In the Tool menu, select Server Summary to check the license status.

To edit server settings:
1. Right-click on a server icon & then click Settings.
2. Enter the required settings, then click OK.
To remove a server:
1. Right-click on a server icon &4/
2. Select Delete and click Yes at the confirmation prompt.

You may sort servers under server groups or devices under servers according to name or type. To do this
Q right click on any server group or server under Edit mode and choose Sort by... Name or Type. You may
& also drag and drop icons to rearrange order manually.
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Maps

The Map window displays indicator icons representing the devices and servers that the NCS client monitors. They are
shown against map backgrounds. This enables quick and easy control and monitoring of devices according to their location.
Multiple maps of different locations and at different scales can be used, as described below. To change the size, pan
settings and brightness of map graphics, see page 70.

Q To carry out the functions described below, you need to be in Edit Mode and Commit after setup (see
page 26).

Map Hierarchy

Maps can be layered in a hierarchical structure. Typically, the top—level (parent) map is at a large enough scale to cover the
geographical areas of all the lower-level (child) maps. Each child map is assigned an icon on the parent map. Clicking a
child map icon shows the child map in the Map window. Multiple levels of child maps can be defined.

= E Taiwan

=B MUUO Taipei

Q The default top level map is provided by NUUO. To change this, see the section To edit map settings
" | below.

Adding/Editing/Removing Maps

To add a child map to a parent map:
1. Ensure that the client is in Edit Mode and that the MapView window is selected.
2. Right-click on the icon for the parent map E then click Add Map.
3. Enter the required details.

4. If you do not want to use the default indicator image, please manual import another image and set to default (For
information on importing indicator images, see page 31.).

5. Click OK. The map you added appears in the tree structure of the MapView window.
6. The map indicator appears on the parent map. Drag it to the position you want.
To edit map settings:
1. Right-click on a mapicon BT, then click Settings.
2. Enter the required settings, then click OK.
To remove a map:
1. Right-click on a mapicon B

2. Select Delete and click Yes at the confirmation prompt.

You may sort maps and devices on the map list according to name or type. To do this right click on any
Q map under Edit mode and choose Sort by... Name or Type. You may also drag and drop icons to
“=1" |rearrange order manually.
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Servers/Devices on Map

Each Main Console server or device can be assigned to a map. An indicator for the Main Console server or device is
displayed on the map at the position you choose. This allows quick and easy control and monitoring. You can control the
orientation of indicators as well as the appearance of accompanying text and the information it shows. The NCS Client
software comes with default indicator images, but you can also import your own.

Q To carry out the functions described below, you need to be in Edit Mode and Commit after setup (see
page 26).

Importing Indicator Images

To import an indicator image:
1. In the Edit menu, select Import Indicator Image.

2. From the drop-down list, select the type of indicator image you want to import.

Import Indicator Image 1 x|
=
Import
Delota |
oK
[~ Derauit

3. Click Import, browse to the required image file, and open it.
4. Click OK.

Q If you want to set a specific image as the default for a file type, select the image, then select the Default
“e | checkbox.

Adding/Removing Device Indicators
There are two ways to add device indicators to a map: MapView display and ServerView.

To add device indicators to a map in MapView:

1. Ensure that the client is in Edit Mode and that the MapView window is selected.

Click on the map icon E for the map you want to add an indicator to. This displays the map.

2

3. Right-click on the map icon.

4. Click Add Server Indicator, Add Camera Indicator, Add Metadata Indicator or Add I/O Indicator, as required.
5

From the drop-down list, select a device.

J Camera Configuration

5 Select Camera
| [Demo jl

Indicator [con:

e —
G =
=
N =
¥ Show coverage area

Range ’Ji 100
a
Radian %5 1o 285
270 @ ag

180

apphy to.. | v ok | [ X cancal |
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6. Choose an indicator.

4 Camera Configuration
Select Camera
[Dema ~|
Indicator [con:
-
N
~ Q
7 [ Show coverage area
Range — '— 100
0
Radian %5 1o 285
ZTU@QU
180
[ Apply to ... ] \1\/ 0K |[X Cancel]

7. When the device is a camera select Show Coverage Area to set the Range and Radian.
8. Click Apply to... if you need to apply settings to other camera indicators.
9. Click OK.
10. The device indicator will appear on the map. Drag it to the required location.
To drag a device indicator to a map from ServerView:
1. Ensure that the map you want is displayed.
2. Click on the ServerView window.

3. Directly drag a device to the desired location on the map.

@ If you are in MapView and click on a device which has already been added to a map, the map for that
"~ | device will be displayed.

To remove a device indicator from a map:
1. Right-click the indicator.
2. Click Delete.

3. Click Yes in the confirmation window.

Edit Device Indicators

An indicator image can be rotated, mirrored, or changed. The image can also be set to refer to a different device than the
one originally chosen.

To rotate a device indicator to a preset angle:

Once a device indicator has been added or dragged to a map, the indicator image can be rotated. This is useful to show
which direction a camera is pointing.

1. Right-click the indicator or right-click the device from MapView.

2. Click Rotate and choose an angle (preset angle 0, 45, 90, 135, 180, 225, 270, or 315 degrees).

Q The radian, range, color and area of Camera Indicator can be set to show camera coverage.
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To rotate a device indicator to an arbitrary angle:

Sk
— icon from Edit toolbar.

1. Right-click the indicator or right-click the device form MapView, or click
2. Click Rotate Arbitrary.
3. Use the rotation handle to rotate the indicator to the desired angle, then click to fix the angle.
4. Click Rotate Arbitrary again to close this option.
To mirror a device indicator:
Indicator images can be mirrored (flipped horizontally) so that a mirror image is displayed. One use would be to show in
which direction a camera is pointing. For example, a default image may show a camera pointing left.
1. Right-click the indicator or right-click the device form MapView.
2. Click Mirror.

3. Mirroring would then have it facing right.

Q The mirror command is a toggle. To un-mirror a previously mirrored indicator, follow steps 1 and 2 again.

To change a device indicator image:
1. Right-click the indicator or right-click the device form MapView.
2. Click Settings.

3. Select the indicator image you want, then click OK.

oy ; .
‘ ; i

To remove a device indicator from a map:

To import a new indicator image, see page 31.

1. Right-click the indicator or right-click the device form MapView.
2. Click Delete.

3. Click Yes in the confirmation window.
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Coverage

Coverage is a defined period or periods of time. This is used for the following purposes:

¢ To define the times a user can log in to the system and use the NCS client. This coverage is applied according to
the local time of the NCS Client.

e To define the times that an alarm is active. This coverage is applied according to the local time of the source Main
Console server.

Q To carry out the functions described below, you need to be in Edit Mode and Commit after setup (see
page 26).

Adding/Editing/Removing Coverage

To add a coverage:

1. Ensure that the client is in Edit Mode and the Configuration window is selected.

2. Right-click on the Coverage folder icon -[ | Cawerage , then click Add Coverage.

[ ] (% cxen )

3. Inthe Coverage Dialog window, enter a coverage name and, if you want, a coverage description.
4. Choose a coverage mode:

* General is for regular coverage periods.

* Specific Day means that this coverage applies to a specific date only. Choose the date from the drop-down list.
5. Select the time periods you want for this coverage.

* Drag over the time periods you want. Selected periods appear in blue.

* To remove periods, select Remove Time Period and drag over the periods you want to remove.

e To clear all selected periods, click the Clear All button.

6. Click OK. The coverage you added appears in the tree structure of the Configuration window.

Q You can also add a coverage from the Edit menu by pointing to New Object, clicking on Coverage then
following steps 3 — 6 above.

To edit a coverage:
1. Right-click on the coverage icon for the coverage you want to edit.
2. Select Edit Coverage.
3. Edit the settings as required.
4. Click OK.
To remove a coverage:
1. Right-click on the coverage icon for the coverage you want to remove.

2. Select Delete Coverage and click Yes at the confirmation prompt.
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User Groups and Users

System administrators can control who can use the NCS client, when they use it, their ability to perform various functions,
and which devices they can access. Privileges are assigned via user groups. For each user group, an administrator can
define permitted functions as well as which devices the users in that group can access. Password control, permitted access
times (see page 34), and a matrix profile (see page 47) are configured in the settings for each user.

Q To carry out the functions described below, you need to be in Edit Mode and Commit after setup (see

page 26).

Adding/Editing/Removing User Groups

To add a user group:

1. Ensure that the client is in Edit Mode and that the Configuration window is selected.

2. Right-click on the User Group folder icon "] UserGroup , then click Add User Group.

[E] User Group Configuration
Group Name: [Helpsenicesaroun
Group Deseription [
Function Privilege Device Access
[ Alarm Management * Forus Lost T~
# GARoom
¥ View Alatm Image 2 Link
[ Open Live video Vo
00 Vivotek IF7161-Room 1011
[ Open/Backup Recorded Video O Vivotek FDT141-Room 102-
D05 JPN-Room 104-2
[ PTZ Contral 00 4P-Room 104-3
5 - @ M Vo-Room 105-3
) KiY-Alarm 201
[ Gontrol Digital Dutput Cireels-Alam 204
¥ View and Search Metadata ransaction [ Strests-Alam 205
= C19a Test Pos
[ Remote Deskiop L@ TestPos =
¥ Operate Device Order = O bemo
g TestAccess Contral
Iv Central Backup [19@ TestFos
[+ View System Log 160 Test LPR =
™ Allow Using Talk <] m ] [2]
7 =

3. Inthe User Group Configuration window, enter a group name and a group description if required.

4. In the Function Privilege area, select the privileges for members of this User Group:

* Alarm Management — allows users to change alarm status on the Alarm Management window (see page 61).

| | Alam Information
Alarm Name:

Souree Device
Event Type:

Alarm Image —

Date J Time:

Saurce Server Inforration
Server Mame

Date J Time:

Address

City.
State:

Zip

Other Infarmation:

Contact | Histary |

Digital Output

Name Phone Contact Time.

Alarm Guide

[Ararm one

[Local - Taipei Strets

|General Mation

[2010-11-04 10:45:41

[Local

[2010-11-04 10:45:41 (GMT+08:00)

Alarm Status
Status:
Priority:
Owner.

Nate:

New -

Critical -
admin v

°

* View Alarm Image - allows users to see a snapshot from the camera as an icon in the Recent display (see
page 61) and view snapshot on Alarm detail Window.
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5.

Open Live Video — allows users to open a live video window to view image of the camera and related devices
from the Alarm Detail window or by right-clicking on a camera indicator.

Open/Backup Recorded Video — allows users to open or back up recorded video of the camera and related
devices from the Alarm Detail Window or by right-clicking on a camera indicator.

PTZ Control - allows users to control the PTZ (pan, tilt, zoom) settings of compatible cameras. This option only
works when users also have Open Live Video authority. Priority of PTZ control of the user group is defined by
numbers 1-10, with 1 for the highest priority. Users with higher priority can obtain PTZ control from other users.

Control Digital Output — allows users to control digital outputs such as alarms. This option only works when
setting 10 devices as related devices in Alarm setting (see page 40 ).

View and Search Metadata transaction — allows users with authorization to search metadata transactions.
Remote Desktop — allows users to open a remote desktop.

In the Device Access area, choose the devices which members of this User Group will be able to access. If the
devices have not been enabled in Device Access table, users still don’t have allow to use above functions.

6. Click OK. The user group you added appears in the tree structure of the Configuration window.

To edit a user group:

1.

2
3.
4

You can also add a user group from the Edit menu by pointing to New Object, clicking on User Group
then following steps 4 — 6 above.

For quick add a new User Group, please use Insert Copy option by right-click on the User Group which
you want to copy.

Right-click on the User Group icon < for the user group you want to edit.
Select Edit User Group.
Edit the settings as required.

Click OK.

To remove a user group:

1.
2.

Right-click on the User Group icon - for the user group you want to remove.

Select Delete Group and click Yes at the confirmation prompt.

Adding/Editing/Removing Users

Add new users and modify or remove existing users. You may choose to add Central Users directly in the system or
import users from MS Active Directory (MSAD) as Windows Users.

To add a Central User:

1.
2.

Ensure that the client is in Edit Mode and the Configuration window is selected.

Right-click on the User folder icon -] User , then click Add Central User. The User Configuration window
appears.

Page - 36



NUUO Central Management System
User Groups and Users

User Configuration
User Marne: |
Fagsword, |
Confirm Password: |
Description: |Admm|stralur
Email |encchen@nuuu.wm
Phone Number: |UE1B§U4227
User Group: |Administratnr j
Coverage: [atways @
Initial Wiew Group |Nune j @
-
Vo

In the User Configuration window, enter a user name.
If password access is required for this user, enter and confirm a password.

Enter a description if needed.

o g A~ w

If you want this user to receive auto alarm notifications by email or SMS, enter the email address and/or Cellphone
number.

7. Choose a user group, a coverage (see page 34), and a matrix initial view group (see page 47) from the drop-down
lists. The coverage here is based on the NCS Client’s local time.

8. Click OK. The user you added appears in the tree structure of the Configuration window.

Q You can also add a Central user from the Edit menu by pointing to New Object, clicking on User then
following steps 3 — 8 above.

To edit a Central user:
1. Right-click on the user icon . for the user you want to edit.
2. Select Edit User.
3. Edit the settings as required.
4. Click OK.
To remove a Central user:
1. Right-click on the user icon . for the user you want to remove.

2. Select Delete User and click Yes at the confirmation prompt.

Enable Disable User Account option on User Configuration window also can reject this user account to

You may sort users and user groups on the configuration window according to name. To do this right click
on User or User Group under Edit mode and choose Sort by... Name. You may also drag and drop icons
to rearrange order manually.

Q login NCS system.
Q
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To add / remove / synchronize a Windows User:

1. Right-click on the User folder icon -[__] Uzer , then click Add/Remove/Sync. Windows User. The Select Group /
Select User window appears.

2. Check users or folders under Select Active Directory user(s) and click OK to add Windows Users.

Select User

Active Directary Damain: |nuu0-0x6p?g39b9

Select Active Directary user(s):
=] 3 Administrators (Administrators TESEE T ZERSIMNTTET & |

O5 Elacku\;':'u Oparators (Backup Operators HEEESR{0EHE
053 Guests (Guest IRIGTEEHFD User BHEMRE S FHRHRT
—--I3 HelpSenicesGroup EHBERE X .L3H58)

[F182 SUPPORT_388945a0 (CN=Micrasoft Corporatior
O Metwork Configuration Operators (RESEERFEPAIAEST
=3 Power Users (Power Users BEE B 5 FRERSIEY a5
O Remaote Desktop Users (FE3SEEEE DAV S ISHEET
M Replicator (F1EMIZPAERER)

[. .SelectAII ” Deselect Al

Group mapping

MSAD Group Central User Group
JIHelpServicesGroup HelpServicesGroup
JPower Lsers Power Users
JReplicator Replicator

) Adrministrataors Adrninistrator

(/o ] (X canal]

Q Click Select All to check all available users and folders, or click Deselect All to uncheck all users.

Group Mapping:
Selected Windows users will be grouped according to default mapping:

MSAD Group  Central User Group

Administrator Administrator

No Group Default User

Other Groups Automatically add a new user
group with the same name

Q You may further modify group setting for each user manually. Please refer to edit a Central User on page
37 for details.

Q Editable columns for Windows Users include Email, Phone Number, User Group, Coverage, Initial
" | View Group and Disable User Account.

3. Synchronization results will be displayed for confirmation. Please refer to the default solution for all conflicts:

New accounts added from AD domain Add to Central System

Accounts from AD domain removed Delete from Central System
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-:Qj

To configure automatic synchronization on Windows Users:

1.

o » 0N

User Groups and Users

Account description modified

Update description

Encountered admin account

Skip admin account

Newly added account from AD domain conflicts

with existing central user account

Replace Central user account

Current logged in account removed

Skip login user

Active Ditectory Sync Tool

82 administrator  EIREREBIREIAEIERS
[F82 45PHET Acoount used for running the &...  Add to Central System
[FA8%Hehsssistant 1R {RiRIREIETIES
[M83SUPPORT 3. ESRESAREERFMEEIES  Delste from Central System

Conflicts:
User Marme Description Solution
[8%3aa &dd to Central System

Add to Central System

add to Central System

b 0K | ’X Caneel ]

Uncheck items to skip applying solution to NCS Client user account settings.
For example, if you uncheck an “Add to Central System” solution, the new account will not be added to NCS

Client’s user account list.

Instead of manually adding and updating Windows users, you may also configure the system to

automatically synchronize all Windows users at a specific period.

Right-click on the User folder icon -] User , then click Auto. Sync. Windows User Setting. The Automatically

Synchronized Setting window appears.

Check Automatically synchronize Windows

users.

Configure synchronized period to start every __ days.

Define synchronized time to decide what time the synchronization should start.

Click OK.

Auntomatically Synchronized Setting

Automatically synchronized setting

Synchronized period:

Synchronized time:

v Automatically synchronize Windows users

1 Dayis)

10:00 =

v

oK ’)( Cancel ]

f@; Auto synchronization will apply all default solutions to conflicts.
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Alarms

The alarm functions of the NCS Client can be configured to monitor many different events triggered by cameras, input
devices, output devices, and servers.

: Q To carry out the functions described below, you need to be in Edit Mode and Commit after setup (see
page 26).

Adding/Copying/Editing/Removing Alarms
To add an alarm:
1. Ensure that the client is in Edit Mode and the Configuration window is selected.

2. Right-click on the Alarm folder icon -] Alarm , then click Add Alarm.

[E] Alarm Configuration
General Auta Motify (NCS Client)
Alarm Mame: |Dem0 Alarm v Goto Map Layer @
Alarm Description: |furlesting v Popup Live Yideo Window

Alarm Priarity: Critical hd

[ Play Sound
Alarm Owner admin -

Send to Matrix: Dermo Matrix -

Coverage: Always - @
Group: Group 1 -
Rearm Interval: 5 secand

I Show Related Camera to Matrix

Iv¥ Close Alarm {17
" Auto Close Alarm Auto Motify (NCS Server)
& Close Alarmn After 30 seconds — ] [ =
[ Recording on NCS Client
[ Alarm Management Guide l
@
=0 SenerGroup ~ DP Source Server Disconnec|s =-[# 0 SenerGroup ~
- [F= TestServer +- [0 Systermn Log - [F= TestServer
O Sureeillance Server =¥ Metadata Channel Event O & vivotek IPT161
2 Vivotek IPT161 & Transaction Start O & vivotek FDT141
& Vivotek FDT141 & Transaction End O ® JPn
3 JPN & Open Cash Drawer 0o vo
2 W0 & Connection Lost o2 ny
>N & User defined 1 ] * Streets
» GStreets M User defined 2 O ® Office
2 Office He User defined 3 O ® Immervision
2 Irrmervision M Vser defined 4 O ® Camera Occlusion
® Camera Occlusion HA User defined 5 ® Counting
2 Counting ,_-E Uger defined & 2 Missing Object
* Missing Object v Eﬁ User defined 7 v 2 Foreign Object
< > < > 2 Focus Lost [
v oK [ X Cancel l

3. Inthe Alarm Configuration window, enter an alarm name and alarm description.
4. Choose an alarm priority and an alarm owner from the drop-down lists.
5. Choose from the following settings:

* Choose a coverage (default coverage is Always). The coverage here is based on the alarm source device’s local
time.

e Enter a rearm interval. If the rearm interval is too short (default interval is 5 sec.), multiple alarms may be
triggered by certain events such as motion.

*  You can pick from two Close Alarm options. If you want the alarm to close automatically when the triggering
event ends, check Auto Close Alarm. You can also set a timer for the alarm to close automatically after a
couple seconds.

* If you want to record video locally whenever this alarm is triggered, check Recording on NCS Client.
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To enable recording on NCS Client, you must check Recording on the Client under Edit — NCS Client
Setting — Record Setting. See page 24 for details.

If you do not want to put the alarm into effect straight away, check Disable Alarm.

If you want, click Alarm Management Guide and enter text. This text appears in the alarm detail window (see
page 64). The text also appears when users point to a device for which the alarm is active.

6. Select options in the Auto Notify (NCS Client) area:

7.

10.

11.

o

If you want the map window to automatically display the map for the alarm’s source device, select Go to Map
Layer. User can click on & icon to stop this function when day to day use.
For a camera alarm event, if you want a live video window from that camera to pop up, select Popup Live Video

Window. Up to three live video windows can be open at a time. User can click on % icon to stop this function
when day to day use.

If you do not want to send the video of an alarm source camera and a related camera to matrixes, check Disable

to Matrix button 3 .

If you do not want alarm events to replace old events on the Matrix if the Matrix is full and users do not close old

events, check the Disable Matrix Popup button B

NCS system will auto filter the same alarm of one camera, it can’t allow one alarm of a camera to use
more than one popup live video windows.
If you want a sound to play when the alarm is triggered, check the Play Sound box, then click the URL button

and browse to a sound file.

For a camera alarm event, if you want the camera’s video feed automatically sent to a matrix, choose a matrix
from the Send to Matrix drop-down list and a Group. If a related camera is selected, you can also choose to
Show Related Camera to Matrix by checking that box.

The options of this section, Go to Map Layer, Popup Live Video Window, Play Sound, Send to Matrix,
and Show Related Camera on Matrix settings apply only to one computer. If users run the NCS Client on
another computer, they will have to configure the settings for that computer. To use Send to Matrix and
Show Related Camera on Matrix, a matrix must be configured (see page 45), and that matrix must be set
to Allow Show Video on Event (see page 85).

Select options in the Auto Notify (NCS Server) area:

If you want the server to send an automatic email to users when an alarm event happens, click the Email button
and then select users.

If you want the server to send an automatic SMS message to users when an alarm event happens, click the
SMS button. The text of the message is [Alarm Name] on [Date/Time).

To configure the server's GSM modem and email settings (including email content), see page 42.

In the Source Device area, select the device/s which will trigger this alarm.
In the Event Message area, select the event/s which will trigger this alarm.

In the Related Device area, select devices which you want to relate to this alarm. For example, an input device
event can automatically trigger a live video popup from a related camera.

Click OK. The alarm you added appears in the tree structure of the Configuration window.

You can also add an alarm from the Edit menu by pointing to New Object, clicking on Alarm then
following steps 3 — 11 above.
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To copy an alarm:

1. Right-click on the icon . for the alarm you want to copy.

2. Select Insert Copy.

3. Configure the alarm as described above.

4. Click OK. The alarm you added appears in the tree structure of the Configuration window.
To edit an alarm:

1. Right-click on the icon ! for the alarm you want to edit.

2. Select Edit Alarm.

3. Edit the settings as required.

4. Click OK.
To remove an alarm:

1. Right-click on the icon . for the alarm you want to remove.

2. Select Delete Alarm and click Yes at the confirmation prompt.

Central Server Configuration Window

The Central Server Configuration window controls how the server keeps alarm records, and also GSM and E-Mail server
settings for auto notification of alarms to users. Go to Edit — Server Configuration under edit mode for this window.

f@? If necessary, consult with your IT administrator for details on these settings.

Central Server Configuration

Alarm | Hotline |

Alarm Recycle Scheduled Central Backup

Keep Closed Alarms 180 dayis) v Enable Scheduled Central Backup @
keep All ather Alarms 180 dayis) Start Time: 14:00 %

Auto recyele alarm image when Recurrence: m

starage is less than ’5— % By ’1— il

To configure server alarm records:

1. In the Edit menu, click Server Configuration.

2. Inthe Alarm Recycle area of the Central Server Configuration window, enter the number of days to keep
closed alarms and all other alarms.

3. Set a storage limit for alarm images on percentage. Recycling will be triggered under the desired remaining

percentage of storage space.

Q The default period of Keep Closed Alarms is 180 days. The NCS system will remove all closed alarms
"=I" | three days old by 12:00 PM every day.

Q The default period of Keep All Other Alarms is 180 days. The NCS system will remove all closed alarms
"=7" | thirty days old by 12:00 PM every day.

Q The default limit for Auto Recycle is 5%. The NCS system will start recycling the oldest images when
"&7" | there is less than 5% storage space left.

To setup scheduled alarm backup:

1. Inthe Scheduled Central Backup area of the Central Server Configuration window, check Enable.

2. Define Start Time and Recurrence of schedule backup.
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Q This backup refers to alarm records and does not include video. For video backup please refer to page
=78

For manual alarm backup:
1. Go to Central Backup under Tools.
2. Choose Full Schedule Backup or Partial Schedule Backup.

3. Check Backup Alarm Image if you would like the snapshots saved as well.

Ceniral Backup

Manual Backup

" Full Schedule Backup

& Partial Schedule Backup
Start Time: 2010M1/08 07TAS FF = 5

End Tirme: 20101108 07:15 FF = 3

v Backup Alarrn lmage

Start Backup | ’ Cancel

4. Click Start Backup to start.

Q This backup refers to alarm records and does not include video. For video backup please refer to page
= |78,

Central Server Configuration

Alarm  Hotline I

E-Mall GEM Madem

“SMTP Senver | Fort [one -]
*Part: ’25— [~ Secure connection (SSL) Baud Rate 'h‘
*E-Mail Sender | FIN Cade: [
E-Mail Subject: | Test Phane: [

Body Content: Send Test Message ]

[~ SMTP server needs authentication

——
—

[ Send Test Mail ]

[\/ Ok ] l X Cancel

To configure system auto notification via email:
1. In the Edit menu, click Server Configuration. Select the Hotline tab.

2. Inthe E-Mail area of the Central Server Configuration window, enter an SMTP server, port and select Secure
connection (SSL)

3. Enter an email sender, an email subject, and the body content of the email.

4. If the SMTP server requires authentication, check the box and enter the user account name and password.

5. If you want to send a test email, click Send Test Mail.

Page - 43



NUUO Central Management System

Alarms

To configure system auto notification via SMS:

1. Inthe GSM Modem area of the Central Server Configuration window, select a port and a baud rate from the
drop-down lists.

2. Enter a PIN code if required.

3. If you want to send a test message, enter the destination phone number and click Send Test Message.

@ NCS system will auto filter the SMS for the same alarm, one alarm can't trigger another SMS before one
& | SMS send out.
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Matrix System

The NCS Client provides feeds over the Internet to multiple video matrixes. Each matrix can display images from up to 64
cameras, along with text above each image including information about the camera and server.

-:Qj

Adding/Editing/Removing Matrixes

To add a matrix:

To carry out the functions described below, you need to be in Edit Mode and Commit after setup (see
page 26).

1. Ensure that the NCS Matrix system is running, either on the same computer as the NCS Client, or on another
computer.

2. Ensure that the client is in Edit Mode and the Configuration window is selected.

3. Right-click on the Matrix folder icon --[__] Matrix , then click Add Matrix.

Matrix Sefting Matrix Setting Matrix Setting
General | 050 | Metagata | General 08D | Metadata | General| 05D Metadata |
Configuration v Enable camera 03D ¥ Enable Metadata overlay
Matrix Narne: |Dem0 Matri Foreground Foreground
Font | Tahoma | Font |t Tahoma |
IP Address: |1 92.168.1.68 St m Size: m
Part: 5210 Color [ 1 Colar [ 1
W Bold v Edge Iv Bald v Edge
Backaround Background
Rendering Option Sl - = Sl - v:
o e it ) (et Transparency: — 4 Transparency. — | 40
Infa
W Server Name
I Camera Mame
W Camera Type
v Bitrate
lv ok | [ X cancel l fv oKk | l X Cancel ] v ok | l X Cancel ]

* To choose the rate at which camera images are updated on the matrix, enter a camera tour interval.

5. Under OSD in the Matrix Setting window

* For text displayed on the matrix, select a font, a font size, and font styles.

¢  Choose what information is included in on-matrix text, by checking Info: Server Name, Camera Name, Camera

-:Qj

To edit a matrix:

1.

Type and Bitrate boxes as required.
Under Metadata in the Matrix Setting window

Select enable or disable Metadata overlay

For Metadata information displayed on the matrix, select a font, a font size, and font color.

You can also add a matrix from the Edit menu by pointing to New Object, clicking on Matrix then following

steps 4—7 above.

Right-click on the icon | for the matrix you want to edit.
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2. Select Edit Matrix.
3. Edit the settings as required.
4. Click OK.
To remove a matrix:
1. Right-click on the icon | for the matrix you want to remove.
2. Select Delete Matrix and click yes at the confirmation prompt.

To configure the NCS Client for a multiple matrix system:

Follow steps 1-7 of the procedure described above, entering the matrix name and port as appropriate for each matrix.

Configuration Configuration
Matrix Mame: | MULIO Matrix 1 Matrix Mame: | MULIO Matrix 2
|IP Address: | 182.168.1.51 IP Address: | 192.168.1.51
Part: 5210 Part: 5220

Test Matris Test Matrix

You may sort matrixes on the configuration window according to name. To do this right click on the Matrix
Q icon from Configuration under Edit mode and choose Sort by... Name. You may also drag and drop
“& |icons to rearrange order manually.
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View Group Management

A View Group (Matrix Profile) stores the Matrix grids, stream profiles and camera positions for one or more Matrixes. (For
information on configuring Matrix grids and camera positions, see page 85). All users can load View Groups, but only
administrators can save and edit them.

f@ﬁ For information on how to setup a Matrix, please refer to page 85.

Before proceeding to View Group Management, please carefully differentiate the terms below:

View Tour: A set of predefined Views grouped to display one after another. Each View is independently configured and
can include different Matrix grid layouts and different video channels.

Camera Tour: A single View that contains more video channels than the chosen Matrix grid layout. All channels will be
displayed in carousel under the same Matrix grid layout.

Grid Tour: A single video grid that contains more than one video channel. The video channel will be displayed one after
another in the grid.

Alarm Tour: You may reserve specific grids in each view for alarm video display. These grids are marked with a
colored corner. When incoming alarm videos exceed the number of reserved grids, the rule for displaying alarm video is
called Alarm Tour. You may choose from two modes, Simple and Salvo.

View Groups can be managed under the View Group List under the System Control Window.

View Group List =
=[] Wiew Group List
—-f CGooup A
= 3% Entrance
2 01 TrM
2 02:NY
@ 03: Tour - Towvr de Tadwan
+ 4x4 Exit
+1-{HH| 22 Hall
=1 View Towr
+ Grovp & - 3uF Entraoece
+ Group A - 44 Exit
+- [ Group & - 22 Hall
 Group B
ff Group C

B cery.. | @Map... |EFcon... | B vie...

To add a new View Group:

Right click on [ View Growp Li#t ang select Add View Group.

To add a new View:

1. Right click on any View Group 1 Growp and select Add View. You will see the View Configuration window.

2. Insert a name for the View in View Name.

3. Alllicensed cameras will be under Available Cameras. Select the cameras you want to add to the View and

press _ Press to remove selected cameras.

4. Use the buttons and D to adjust sequence of cameras.

5. Right click on any camera to choose a suitable stream profile.

6. Click to switch between different matrix grids.
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7. Click E] to assign alarm video channels to show video on event. You are able to define up to 16 different
groups indicated with 16 different colors under Group Setting.

" ¥iew Configuration

Wiew Mame ‘2)(2 Hall

Available Carneras: Selected Carneras: ] =

® TestServer Vivotek IPT161 2 Test Server- NY

¥ |~
® TestServer Vivotek FO7T141 2 Test Server - Streets
2 TestServer  JPN @ Test Server - Office
® TestServer WO 2 Test Server - Immension

® TestServer Carmera Occlus = add

® TestServer  Counting

2 Test Server Missing Ohbject

® Test Server Foreign Object
® TestServer Focus Lost

® TestServer Q& Room
® TestServer Link

® Test Server  WIO Auto Scan Interval 2 Sec.
® Demo QA Room I

2 Demo HAE Alarm Carousel Mode: Simple -

2 Demo Deskiop

2 gpeed Do... VIVOTEK-FDT1! E]
® Speed Do.. D-Link-DCS-66,
b

B (2]

* Snped DN wall

l/ oK ] [X Cancel]

By Clicking on the grids, you assign them as alarm video channels which will display m
alarm associated video when alarms are triggered. The corner of the grid will be L

— Yo

marked with colors that stand for different groups (refer to picture on the right).
For Alarm Configuration, please refer to p. 41 for details.

Note that if no grids are reserved for alarm videos, they cannot be displayed in the matrix. A notification
will be shown in the status bar on the bottom of the NCS Client window.

Maximum channels for each view is 64 chn. This includes those in Grid Tour. Refer to the next section
for more info on Grid Tour.

O Q0

8. Set Camera Tour Interval.

When the number of cameras exceeds the number of Matrix grids, Camera Tour will be activated.
-~ | Camera Tour does not involve changes of Matrix grids. For example, if you assign 12 cameras into a 3x3,
Q' 9 camera grid and set Camera Tour Interval at 2 seconds, the first 9 cameras will be shown for 2 seconds,
then the remaining 3 cameras for another 2 seconds. The circulation continues until manually stopped.

9. Set Alarm Tour Mode: Simple or Salvo

Alarm Tour takes effect when grids assigned as alarm video channels are all occupied, and new alarm
-~ |associated video is ready for display. Under Simple Mode, old alarm associated channels will be replaced
Q' by new ones. Under Salvo Mode, alarm associated channels will go into carousel and be displayed
continuously until the alarm is closed.

Q Camera Tour of a view will be stopped when Alarm Tour starts.

10. Click OK to save settings.

Q View groups can also be saved directly from the Matrix List. Click the Save view group button [d to do
"= this. Referto p.85 for more Matrix settings.

To add a new Grid Tour:
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1. Right click on any View Group ! 1% and select Add Grid Tour. You will see the Grid Tour Configuration

window.

2.

Insert a name for the Grid Tour in Grid Tour Name.

(gg Grid Tour Configuration

Grid Tour Mame: |

Available Cameras: Selected Cameras

@

Grid Tour Interal:

2 =1=10%

Server Name
2 TestSemer
® Test Server
® Test Server
2 Test Semer
® Test Server
2 Test Server
2 TestSemer
2 TestSenver
2 Test Server
P TestSener
2 TestSenver
* Test Server

Camera Name
Vivotek IP7161
Vivotek FD7141
JPN

Office
Immevision
Camera Occlusic
Caourting
Missing Object
Foreign Chject

P TestSener
2 TestSener
* Test Server
P Test Serer

Focus Lost
QA Room
Link

VIO

& |

[

s

Add

Server Name

Camera hName

2 Test Server
* Test Server
2 Test Server

3

JPHN
Vo
[¥hd

0K ] [)( Cancell

All licensed cameras will be under Available Cameras. Select the cameras you want to add to the Grid Tour and

press _ Press to remove selected cameras.

Set Grid Tour Interval.

N o o &

Click OK to save settings.

-:Q;

To add a new View Tour:

under the Selected Cameras

List.

Use the buttons and to adjust sequence of cameras.

Right click on any camera to choose a suitable stream profile.

After defining a Grid Tour, you will be able to include it in the View. It will be displayed with other cameras

1. Right click on [ Tiew Group List 514 select Add View Tour. You will see the View Tour Configuration window.

5} View Tow Configuration
View Tour Mame ‘
Available Views: Selected Yiews: @
Tour Interval: 2 Sec
B Grou.. view [ Group A- 33 Entrance
B Grou.. viewn [ Group A- 4x4 Exit Alarmm View: Mone - @@
BE Groun A- 2¢2 Hall
L3 Add
3 —rT—— (2]
|/ 0K | [ X cancel ]

2.

Insert a name for the View Tour in View Tour Name.

3. All Views will be under Available Views. Select the Views you want to add to the View Tour and press

Add

L=

]. Pressl - I ]to remove selected Views.

4. Use the buttons and to adjust sequence of Views
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5. Set Carousel Interval.

6. Select an Alarm View. When alarms are triggered and alarm related video is ready to be displayed on reserved
grids, View Tour will stop on the selected Alarm View to display the video. For more information, please refer to p.
48 on assigning alarm video channels to show video on event.

7. Click OK to save settings.

View Group List =
. . . =" Wiew Cuoup List
To load a View Group / View / View Tour: =) [ Grovp A
=[] 3+3 Entranc
1. Go to Operate Mode. » mn;mme
) . P 0z WY
2. Go to the View Group List [ Tiew Group List nder the System &, 03: Tour - Tour de Teiwen
Control Window. : gg EI?].{
. . . . . =1 iew Tour
3. To display all Views of a View Group, right click on any of the +. [ Goup A - 3x3 Entrance
. + Crroup 4 - 4 Exit
Groups and choose Load on Matrixes. < [ Growp A - 21 Hal
4. To display one specific View or View Tour, right click on the View / - gﬁig
View Tour and choose Show on Matrix.
B zerv.. | @Map... | B con... | B vie...

To assign users to an initial matrix view group upon startup:
1. Go to Edit Mode.

2. Right click on a specific user under Configuration under the System Control Window.
3. Click on Edit user.
4. Under User Configuration, choose a view group from the drop down list under Initial View Group.
This View group will be started automatically when this user logs in.
[Peditvode | 5] G @ i) [T

Configuration v B X User Narme: ‘

Password: ‘

=) User Group
=| 4 Administrator Confirm Pagsward: ‘

& admin

=10 User

Description: ‘Admmistratur

Email: ‘ErICChEH@HUUU.CDm

T r_l A Phone Mumber: ‘0919504227
: s e
=[] Coverag User Group: ‘Admmlalratur j
o g? P_Jw' 4 Coverage: ‘A\ways j @

=] atri

i Matrix One Initial View Group Group 1 ~| i@

. MNone

| Matvix Two | r S |

B Server List | 2 Configuration v oK

To rename a View / Grid Tour / View Group / View Tour:
1. Right click on the icon and label under Edit Mode.
2. Click on Rename.

To remove a View / Grid Tour / View Group / View Tour:
1. Right click on the icon and label under Edit Mode.
2. Click on Delete.

To edit a View / Grid Tour / View Group / View Tour:
1. Right click on the icon and label under Edit Mode.
2. Click on Settings...

Under Edit Mode, drag and drop to change sequence of Views, View Groups, View Tours, Cameras and
Grid Tours.
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Network Management

NCS Server Management

On the NCS Server Window, administrators can Kill Client, change port of connect, and limit the maximum client connections.

To kill a connected client:

1. Double click on the NCS Server icon to open the NCS Server Window.
2. Choose a client IP and click Kill Client.
To change connect port and maximum connections:
1. Click Stop to cut all connections.
2. Change port of connection and maximum connections.

3. Click on Start to allow connections.

[Bi] NCS Server (License: 30 - Trial) (=)
Main | Configuration
ClientCount | O KillClet | [ EillADClens |
State IP
Service
Server Status: Running Sop
Options
[v ok |[x coma |

To change the NCS Server password:
The default password of admin account is empty. Modify the password from the client software and commit it to the server
as follows:

1.  Open NCS Client Software and log in with the admin account.

2. In Edit Mode, select the Configuration Window.

3. Right-click on the user icon adinin for the admin account and select Edit User.

4. Enter a new password, and then click OK.

5. Click on the Commit button E¥]Commit to commit the modification to the server.

Matrix Management

To edit the Allow Hosts list:

1. In the Start menu, point to All Programs, point to NUUO Central Management Client, and then select NCS
Matrix to start the matrix.

2. Point to the bottom-right corner of the screen, and then click on the General Setting icon I@

3. Click OK to open the Matrix Configuration window.
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4. Click the Allow List button.

Allow Hosts List
[ Allowe All Hosts
192 168 . 1 . A1
Add | Delete ‘
192.166.1.50

« COK | K Cancel ‘

5. In the Allow Hosts List window, deselect Allow All Hosts, and then choose from the following actions:
¢ To add a host, enter the host IP address, and then click Add.
¢ Toremove an IP address from the allow list, choose the IP from the table and then click Delete.

6. Click OK to save the configuration.

To set a matrix password:

1. In the Start menu, point to All Programs, point to NUUO Central Management Client, and then select NCS
Matrix to start the matrix.

2. Point to the bottom-right corner of the screen, click on the General Setting icon E and then click OK.

ersion _’ﬂ
Part: 5210 Allow List
Password:
Confirmed Password
v oK X Cancel

3. In the Matrix Configuration window, enter and confirm the password.
4. Click OK.

To start up NCS Matrix automatically:

1. In the Start menu, point to All Programs, point to NUUO Central Management Client, and then select NCS Matrix
to start the matrix.

2. Point to the bottom-right corner of the screen, and then click on the General Setting icon E
3. Click OK to open the Matrix Configuration window.

ersion _’ﬂ
Fort 5210 Al List
Password:
Confirmed Password
v oK X Cancel

4. In the Matrix Configuration window, select Run Matrix when Windows startup

5. Click OK.
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Importing/Exporting NCS Client Configuration

The NCS Client configuration can be saved to the local PC and loaded back again. The configuration includes:

* Map display settings
e Alarm log Settings
e Matrix Settings

e MatrixView configuration

To save or load other settings such as server settings or map settings, see Loading/Saving NCS Server Configuration
on page 54.

To import or export NCS Client configuration:

|E| NCS Client [admin] [Trial]

:| File | Edit “iew Tools Zoom  Help
| B g5

&

M= Import Configuration l
|H Export Configuration |

Logout
Exit

In the File menu, select Import Configuration or Export Configuration.
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Loading/Saving NCS Server Configuration

The NCS Server configuration can be saved to the NCS Server PC and loaded back again. It can also be reset to default
status. The configuration includes:

e Server settings

e Map settings

* Device settings on maps
e User group settings

e User settings

e Alarm settings

e Coverage settings

¢ Indication import settings

e Server configuration
¢ Address and password of SQL Server
To save, load, or reset NCS Server configuration:

1. Click the icon from Taskbar and enter the password.

NCS Alarm Server (License: 30 - Trial) (=]

Main | Configuration
S0L Server

Wihich S0L server do you want to connect to?

Password for sa

Comfitmed Password:

MNGE Configuration

Sawe, Load and Resel the all the central management configurations,
including servers, maps , users, alarms and so an.

Save | [ Lom | [ Reset NCS Configuation |

Cptions
Alarm Image Path: | DANUUCINGS SevenCMSEventimages

[JRun NS Serverwhen windows startup

2. Inthe Central Server window, click Save, Load, or Reset NCS Configuration.

f@? Restore NCS Configuration will not clear the setting of SQL Server.
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License Management Tool

The license of the software should be registered first when upgrading to NCS V1.3.0 or later versions.

Execute the License Management Tool to activate the license from a dongle or serial number allocated with the software
package, or de-activate the license and then use it on another PC to activate it again.

Both “On line” and “Off line” status of PC environment could execute the tool to “activate” or “transfer” the license. Below list
5 types of license management process:
* To “activate” the license with an NCS System connected to the network, follow the “Activation Online” process.

¢ To “activate” the license with an NCS System not connected to the network, follow the “Activation Offline”
process.

* To “activate” the license from a dongle either with an NCS System connected or not connected to the network,
follow the “Activation from dongle” process.

¢ To “de-activate/transfer” the license with an NCS System connected to the network, follow the “Transfer Online”
process.

* To “de-activate/transfer” the license with an NCS System not connected to the network, follow the “Transfer
Offline” process.

Please refer to the chapter below for detailed steps of each process.

License Management Tool Overview

Execute License Management Tool

1. Execute License Management Tool in Help of NCS Client.

License Management Tool
Activate | Transfer |
S Cam | IfO | POS | AC LPR | Product
<] >
Activate tvpe
¢ Online activation.
o Input SN
© Import BN file:
ol

" Offline activation:
Step 1 : Export server information file:
=

-

Step 2 : Use "Offline Tool" to activate license and get oflline license
file

Step 3 : Import offline license file:

2. The License Management Tool will appear. Please refer to the tool overview below.
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License Management Tool

License Management Tool Overview

Activate

#] License Managemexnt Tool

Activate tab

SN status

Activate | Transfer |

Y [cam [0 [Pos [ac [P [ Product

(<] Im

- Activate type

Online activation

 Onling activation:

 Activate from dongle

& Input SM
£ Import SN file: [ 3

Activate Activate

" Offine activation:

Offline activation

Step 1 : Export server information file:
& Manual key-in Sk on Ofline Tool

= Activate from donole

file

Expart offine pack

Step 2 : Use "Offline Tool" to activate license and get oflline license

Step 3 Import offline license file: 3

Irnpiort: I m p O rt

Transfer

[#] License Management Tool

Transfer tab -
SN status -

Transfer type -

|~ Activate Iransfer |

EN [cam o [pos  AC [ LPR | Product

<| I

~Transfer type:
@ Online
" Offline

Activate/Transfer License

Activate License

Activation Online

1. Open License Manager Tool.

2. Select On line as Activate type.

I Transfer I---_ Transfer

3. Input the SN (Serial number) or Import SN file, and then click on the Activate button.

[#] Licenss Management Tool

X}

Activate | Transfer |

SN [cam [yo [Pos (ac [LPR | Product

&l m

| Activate type

& Online activation:

& Input By |
£ Import SN file: | [}

) Activate from dongle

4. Restart NCS-Client if activated successfully.

| activate_ |
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Activation Offline

1. Open License Manager Tool.

2.  Select Offline as Activate type.

3.  Select Manual key-in SN on Offline Tool or Activate from dongle, then click Export offline pack.

4. Save Request file, and then take it to another PC connected to Internet.

| = C:\Documents and SeHtingsieR |
TRE(F) fRE(E) mAR(Y) HEm | A
@ m~O ¥ Pus =

| #HEE(D) |5 License > BE=E

= W] f
LiLER L I Ofl ineTool.ex il
=

.

LicenseTeol.dll  msverso.dil

el

5. Execute OffLineTool.exe on another PC, Input SN or SN file or insert dongle, then click Activate to send request
file to license server.

Offline Tool

Infarmation:

Activate new SH.

Flease input SM:

Input type
Sever Informatian file path [caDocuments and Sef
SN input:
& Input S M
£ Import SN file: r

~

[revae

6. Save License file, and then take it to the original NCS Client of the NCS System.
£l

j) Please select a filename to save as a new license file.

7. Open License Manager Tool from NCS Client again, select Import license file, and then click the Import button

to activate.

8. Restart NCS-Client if activated successfully.

Transfer License

Transfer Online

1. Open License Manager Tool.
2. Select Transfer Tab, and then check Online as Transfer type.

3. Select SN and click on Transfer button.
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m License Management Tool

Activate  Transfer |

M | Cam |10 | PoS [ac [ LPR | Product
7 1E4-OE4E-BS80-F3,.. b4 -

se Actva...

m 1} m

-~ Transfer type:

& Online
 Offline

4. Restart NCS-Client if transferred successfully.

Transfer Offline

1. Open License Manager Tool.
2. Select Transfer Tab, and then check Offline as Transfer type.

3. Select SN, and then click Transfer button to transfer SN.

m License Management Tool

X

Activate  Transfer |

SN | cam |10 | Pos [ac | LPR | Product

7 AE4-OF4E-B580 64 056 64 MNCS Base  Achiva,..
m i1} m
-~ Transfer type:

¢ Online

(+ Offline

4. Save Request file. Copy request file to another PC connected to internet.

5. Execute OffLineTool.exe on another PC, check Transfer SN and click Transfer to send request file to license
server.

6. Check Transfer Completed.

Q\ User must copy the request file to another PC and send it to the license server, otherwise the SN cannot be reactivated!!

\ NCS Server cannot connect to SQL Server without NCS Base License.
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Part 3: User Functions (Day to Day Use)

This section describes function and operations of the client in day to day use, including alarm management and view live
video on NCS Matrix.

The commands which a user can access are governed by the user group privileges assigned by the
administrator. For this reason, some of the commands described in the section may not be available to
each user.
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Operate Toolbar

The Operate toolbar controls common functions connected with map view, display and control of actions triggered by
alarms.

I e M G -

It includes seven buttons:

» The Disable Go to Map button =t . When selected, alarm events cannot change the map view.

e The Disable Popup button @ . When selected, alarm events cannot trigger a live video popup.

e The Disable Link between Map and Matrix button &8 . When selected, links between Map and Matrix View
devices cannot be displayed on the NCS Client.

If users enable Link between Map and Matrix, selected cameras on the map can be highlighted on the
Matrix View and vice versa.

¢ The Disable to Matrix button [ . When selected, alarm events cannot send alarm source camera and related
camera video feed to matrixes.

¢ The Disable Matrix Popup button B . When selected, video of new alarm events cannot replace old events on
the Matrix if the Matrix is full and users do not close old events.

* The Close Sound button & . When selected, alarm events cannot trigger a sound.

+  The Lock System button L., Click to minimize system to taskbar. Please note to unlock the system you must
input username and password.
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Alarm Overview Window

The Alarm Overview window shows recent alarm events in various formats, and is also used to show alarm query results
and log messages. For any alarm displayed in this window, an Alarm Detail window can be opened. This enables easy
management of alarms. There are five tabs in the window: Recent, Real Time, Message Log, Output and Output2. The
first three tabs show recent real-time alarm information, and the remaining two tabs show query and search results. The
function and use of these tabs is described below.

Recent Tab

B Hy MG My EG B By

jemo femo fema iemn fema jema femo
WUUO Taiwanidema(2) NUUO Taiwaridema(2) HUUO Taiwaridemo(2) NUUO Taiwan:demo(2) MUUO Taiwaridemo(z) NUUO Tawan:demo(2) MUUO Taiwan:demo(2)

| Erecent B real-Time | = output | ] output 2 | [T]Message Log

The Recent tab gives a display of recent alarm events in icon format. When the alarm event is triggered by a camera, the
icon normally shows a snapshot of the video feed from that camera at the time the alarm was triggered. However, when the
camera signal is lost or the user does not have authority to view snapshots from that camera, or when the event is triggered
by another device, other icons are displayed. The various icons and their meanings are shown below.

Event Message Snapshot for Camera Events, including General Motion,
Foreign Object, Missing Object, Focus Loss, Camera Occlusion

Event Message Picture for Camera Event of Signal Lost.

of

Event Message Picture for /0 Event of Digital Input Triggered.

I

Event Message Picture for Metadata Event without an associated camera or
no authorization to view video.

Event Message Picture for Server System Abnormal Events, including Disk
Space Exhausted, System Health Unusual and Source Server Disconnect.

=

Event Message Picture for Server System Operational Events, including
Start/Modify/Stop Smart Guard, Schedule, Live Streaming Server, Remote
Playback Server, Start/Stop Manual Record, Modify Confiquration,
Enable/Disable Channels, Lock/Unlock System.

”
-
L3

Event Message Picture for Device Authority Deficiency; The user does not
have the authority to view the snapshot of that device.

To control the number and size of icons, see page 64.
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.
Real-Time Tab
Rest e === Click on tab to
gl Priority State Alarm Mame: Event Type Source Server Source Device Description Ovmer
01 Crical Tiew Ter General Matian WO Taan Jemolz) adin filter alarms.
0l Critical Hew demo General Mation ML Taivian demo(2) admin
0l critical Hew demo General Mation ML Taivwan demo(Z) admin
Wl critical Hew demo General Mation MU Taiwan demn(z) admin
0l critical Hew demo General Mation MU Taiwan demn(z) admin
0l critical Hew demo General Motion WLILIC Taiwan demo(2) admin
0l critical Hew demo General Motion WLILIC Taiwan demo(2) admin &
< >

ERecent |GiReakTime |3 output | Tloutput 2 | T]Message Log

The Real-Time tab gives a list of alarm events as they come in to the client. For client configurations where a lot of devices
are being monitored, a great many alarm events may be received. To display only relevant events the user can filter by
Priority, State, Alarm Name, Event Type, Source Server, Source Device, Owner, and Time. In addition, the number of
displayed alarm events can be controlled (see page 64).

To filter by priority:

Click the Priority button. From the list, select the priorities for alarms you want to display. ; e ] e
j Marmal z In Progress

To filter by state: S,

Click the State button. From the list, select the states for alarms you want to display. o e

To filter by alarm name:
1. Click the Alarm Name button.

“F Alarm Name Fitter

i Clear 4l

Alarm Name
£, General Motion
% Signal Lost

7 o] [X e ]

2. Inthe Alarm Name Filter window, select the alarm names for the alarms you want to display.

To filter by event type:
1. Click the Event Type button.

I Event Type Filter
[ Selectal 1 [ Clemial
Event Type L]
[JIGeneral Motion
[IFareign Object

CMissing Object
[CIFocus Loss

Camera Orclugion
CGamera Signal Lost
Disk Space Exhausted
System Health Unusual
Digital Input Triggered
[ZIEnable Channel
(iDigable Channel
C15tart Smart Guard

Stop Smart Guard

[¥] CModify Smart Guard M

7 o] [X e ]

2. In the Event Type Filter window, select the alarm names for the alarms you want to display.

To filter by source server or source device:

1. Click either the Source Server or the Source Device button.
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“ Source Server and Source Device Filter

= [0 ServerGroup

= [

2 Camera 2

# camera 3

[#] 7 Camera L-Input 0
[¥] 57 camera 1-Input 1
[¥] 57 Camera 1-Input 2
[%] 57 camera 1-Input 3
[¥]"} Camera 1-Output O

[ Camera 1-Output 1
' Camera 1-Output 2
[#]% Camera 1-Output 3

7] (X oo ]

2. Inthe Source Server and Source Device Filter window, select the server/s, the camera/s, |1/O device/s or
metadata device/s for the alarms you want to display.

To filter by alarm owner:
1. Click the Owner button.

Select User
MAME Description
& admin Adrninistrator
& Userd
& Userd

ST

2. Inthe Select User window, select the owners for the alarms you want to display.

To filter by time:
Click the Time button. From the list, select the period (1 Hour, 1 Day, 1 Week, or 1 Month) for alarms you want e :
to display. 1 0oy

1 veek
1 Month

: Q The above filter options can also be accessed by going to the Tools menu, pointing to Real-Time Alarm
" | Filter, and clicking on the filter option you want.

Output Tab and Output 2 Tab

The Output and Output 2 tabs show lists of alarm event query results (see page 74) or alarm event search results from the
Advance Alarm Search tool (see page 83). The lists can be ordered according to Priority, State, Alarm Name, Event
Type, Source Server, Source Device, Description, Owner, or Time.

outpuE === Click on tab to
'] Priority State Alarm Hame Event Type Source Server Source Device Description Owner Time

il it e o General Fokion NO0S Tawan — demoll) adroin O EG S B e order |iStS.

il critial New demo GeneralMckion UL Taiwan dema(1) admin 2008-01-07 L0:33:27

0l critical New demo GeneralMction UL Taiwan dema(1} admin 2008-01-07 L0:33:23

Lm Critical Mew demo General Mokion NUUO Taiwan demol1} admin 2008-01-07 10033:21

Lm Critical Mew demo General Mokion NUUO Taiwan demol1} admin 2008-01-07 10033:20

Lm Critical MNew demo General Mokion NUUO Taiwan demol1} admin 2008-01-07 10:33:19

Lm Critical MNew demo General Mokion NUUO Taiwan demol1} admin 2008-01-07 10:28:10

Wl critical New dema (General Mation NUUG Taivan demo(1) admin 2008-01-07 10:28:07 -

Erecent |EElrealTime | = output | ] output 2 | [TIMessage Log

To order lists in Output and Output 2 tabs:

Click the button at the top of the column you want to order by. For example, if you want to order by time, click the Time
button. To reverse the order, click the button again.

Message Log Tab

This tab displays messages from the server. The displayed messages are as follows:
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* NCS server failed to execute SQL command
¢ The disk space of NCS server is low

e The license of NCS server is missing

* Failed to connect to matrix [matrix name]

* Failed to connect live video on matrix [matrix name]

Alarm Log Settings

The Alarm Log Setting window features controls for the Recent and the Real-Time displays. It also includes the option to
display the local time of the source Main Console server for alarm events.

To configure alarm log settings:

1. In the Edit menu, click Alarm Log Setting.

Alarm Log Setting Edit Fields
Recent Alarm v Show Alarm History
Display Count; 10 (0..99) Available fields: Show these fields in this order:
Image Size: 8060 il Local Tirme Attachment
Assigrer Alarm Record Attachment
i Alarm Mote Pricrity
Real-time Alarm Status
) Alarrn MNarme
Display Count: 100 (0.999) Event Type
Source Server
[~ Show Source Server Local Time Source Device
Description
Crwrier
Qutput and Cutput? Alarm Tirne
Edit Filds
| v K | ’ X Cancel ] [ Diefault ] | v K ‘ [ X cCancel ]

2. Inthe Alarm Log Setting window, configure the following options:

* Inthe Recent Alarm area, enter a display count in the range 0 to 99. This controls how many icons can be
viewed at one time when the Recent tab is selected.

* Inthe Recent Alarm area, select the Image Size from drop-down list. This controls the size of icons viewed
when the Recent tab is selected. There are four image size, 80x60,160x120, 240x180, 320x240.

* Inthe Real-Time Alarm area, enter a display count in the range 0 to 999. This controls how many alarm events
can be viewed at one time when the Real-Time tab is selected.

* If you want to view alarm event times in the local time at the source server, check Show Source Server Local
Time.

¢ To customize desired output fields in the Output and Output2 windows, click Edit Fields.
3. Inthe Edit Fields window you may customize on which fields to display in the Output and Output2 windows.

¢ Check Show Alarm History to include Alarm Note in available fields.

« Clickon ™ to add new fields into display or click on . to remove them. Clickon & or ¥ to adjust order.

*  Click on Default to reset to default settings.

Alarm Management Window and Batch Alarm Management

For any alarm displayed in the Alarm Overview window, an Alarm Management window can be opened. This gives
detailed information about the alarm. Depending on the privileges assigned to users, it can also include basic information
options to view live or recorded video feeds, to trigger digital output devices (for example an audible alarm signal), and to
print alarm details. You may also update or reset the state, priority, and owner of the alarm under this window.

To view alarm information in the Alarm Management window:

Right-click on any alarm event in the Alarm Overview window, and then click Alarm Management.
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Alarm Management
-~ Afarm miormation "Afarm Guide
» Alarm Mame: [rarm One 1. Call 1208 for security
- ] T 2. Enahle alarm recaording in section B
Source Device M o 0 3. Lock gates from pier 47 to 96,
eanee AlArm Information —
Date / Time: [2010-11-08 18:04.04
Alarm Image
- “Source Server farmation
- Server Mame |Laca|
Date [ Time: [2010-11-08 18:04.04 (GMT+08:00) Alarm Guide
Address:
Source Server
City:
st Information ——
Zip [123456
TOOIS Other Infarmation:
<] m 12
Contact | H\story'
P —————
[ call ] [ Digital Output ] Name: ILWWWdo Status MNew -
MName \ Fhane \ Contact Time IFiERE IDQB?EE‘1321 Prigrity: Critical -
{leonardo 0987654321 Always i Fax |0985E32147
i Donatelln 0912345678 Always Emai I‘eu@wUD P Owner admin :I'
BRafael 0963852741 Alwvays =
£iMichaslen.. 0387412365 Aways Gontact Time [Riways Alarm Status
Password IBSTI
Contact / History  remie B
camment: General Manager
Ready to call Leonardo (0987654321) @

The Alarm Management window gives details of four sections:

e Alarm Image: The snapshot or icon image of the alarm.

¢ Tools: Direct access to live video, recorded video, send channel to Matrix, show related devices, enable /
disable metadata display and print report.

e Alarm information: Includes Alarm Name, Source Device, Event Type and Date /Time (client local time)

*  Source Server information: Includes Server Name, Date /Time (source server local time) and other contact
details. For more info on how to configure these settings please refer to page 28.

*  Contact / History: A quick link to contact key personnel / A time based log to track status and process of current
alarm. For more info on how to configure these settings please refer to page 28.

*  Alarm Guide: The guide for how to deal with this alarm.

* Alarm Status: Interface to Update or Reset alarm status of State, Priority, Owner and Alarm Note (to note how
users deal with the alarm)

To view live video from the alarm source camera:

1. Right-click on any alarm event in the Alarm Overview window, then click Alarm Management.

2. Click Live Video . The Live Video Window for the camera is displayed.

[E] Live Video Window
Source Device: Local - Vivotek FO7141 (FDT141)
Source Address 182168177
Wideo Resolution 800600
Bit Rate 288 khps
Frame Rate: 2fps
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3. If you want to adjust the video to original video resolution, check Adjust to original video resolution E]

4. Click Snapshot button . The snapshot is displayed and users can save the image or copy it to the clipboard.
5. Click on Alarm Management to go to the alarm management window.

6. Click on Alarm Playback to view alarm playback video if available.

7. Select Streaming profile button to choose different video quality. Options include Original/Main, Recorded,
High, Normal, Low and Minimum.

8. For cameras with two-way audio support, you may click and hold the Talk button for this function. Talking will
end when you release the button. Please note alarm live view pop-ups will be temporarily disabled when using
the Talk function.

9. If the camera is equipped with Audio function, the Audio button will appear. Click to enable audio stream.

10. If the camera is associated to metadata devices, the Metadata button will appear. Click the button to disable
metadata display.

11. To use PTZ control in a live video window:
Click the PTZ button for the following PTZ controls:

. Enable Digital PTZ: Check to switch between digital / physical PTZ

J Preset Point: Choose if available from the drop-down list

J Patrol or AutoPan: Choose if available from the drop-down list, click @ to start and E] to stop
o Direction controls: Up, Down, Left, Right and Home

. Zoom out (-) and zoom in (+) controls

. Focus far (-) and focus near (+) controls

. Speed Dome Menu: If supported, this button enables the Setup Menu of Speed Dome cameras.

The menu will be displayed directly on the video channel. Use the PTZ controls to navigate down
the menu. Other assigned keys with functions will be displayed on the screen, for example the
Focus button for “Select”.

PTZ Control
[~ Enahle Digital PTZ
Freset Paint

Setup Henm

|--Se|ect0ne-- j Exit...

fare =] [@] (EETIRNERET)
o T
@@ I[:g:;:]l:;,;i“” Gatup
[::] Diognostics
Zoom E]
Focus E]

[ Speed Dome Menu

ellect

Focus/Iris: §

e If the camera supports ImmerVision Lens and was correctly configured in Main Console, an additional button

Switch to ImmerVision will appear above the PTZ Control panel. Click on the arrow to select between
Original / Quad Mode / PTZ Mode / Parameter Mode.
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To view recorded video from the alarm source camera:

1. Right-click on any alarm event in the Alarm Overview window, then click Alarm Management.

2. Click Recorded Video . The Remote Playback Window has full playback controls.

[E] Remote Playback Window (Test Server - Streets) - Remote

!
L/l
Playhack Period
T 07:30:27 - T4 07:40:27
Export Period
TF 07:39:37 - FF 07:40:27

3. Click Snapshot button . The snapshot is displayed and users can save the image or copy it to the clipboard.

4. Click Export Video button to save recorded video.
* Set up the cue in and cue out points; the cue in and cue out time will show on the information window.

* Click Export Video button, choose the folder where you want to save the file at, enter the file name and click
SAVE.

* Set the Export Format as ASF or AVI (ASF recommend) and set the Use Profile.
» Select to export (i.e. save) the record video with Audio, OSD and metadata display, or export video only.

* Click OK to save the video.
5. If you want to fix the window size at the original resolution, check Fix original video resolution E]
6. If the camera is equipped with Audio function, the Audio button will appear. Click to enable audio stream.

7. If the camera is associated to metadata devices, the Metadata button will appear. Click the button to disable
metadata display.

8. Click on the Digital PTZ button to enable Digital PTZ. Zoom in and out with your mouse wheel and drag to
Pan / Tilt.

9. If the camera supports ImmerVision Lens and was correctly configured in Main Console, the Switch to

ImmerVision button will appear. Click on the arrow to select between Original / Quad Mode / PTZ Mode
| Parameter Mode.

The default alarm playback period is 20 seconds, including 5 seconds prior to the event and 15 seconds
after. This can be modified in Edit — NCS Client Setting — Instant Playback Setting. Alternatively you
can use Remote Playback system which has full playback controls. Go to Remote Playback under Tools.
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To send Video to Matrix:
1. Right-click on any alarm event in the Alarm Overview window, then click Alarm Management.

2. Click Send to Matrix and select previously set Matrix / Group (see Matrix System, page 45). The video is
sent to Matrix.

To view Metadata display:
1. Right-click on any alarm event in the Alarm Overview window, then click Alarm Management.

2. If the alarm has Metadata display, the Metadata button will appear. Click to disable/enable display. The
Metadata transaction data is displayed on the right.

To view live video from a camera related to the alarm source 1/O device or metadata device:

1. Right-click on any alarm event in the Alarm Overview window, then click Alarm Management.

2. Click Related Device , then point to Open Live Window, and click the camera you want. The Live Video
Window for the camera is displayed.

3. If you want to fix the window size at the original resolution, check Fix original video resolution.

To view recorded video from a camera related to the alarm source I/O device or metadata device:

1. Right-click on any alarm event in the Alarm Overview window, then click Alarm Management.

2. Click Related Device , then point to Open Playback Window.
3. If you want to fix the window size at the original resolution, check Fix original video resolution.

To trigger a digital output device:

1. Right-click on any alarm event in the Alarm Overview window, then click Alarm Management.

2. Click Related Device , then point to Trigger Digital Output, and choose the output device you want to trigger.

To report/print alarm details:

1. Right-click on any alarm event in the Alarm Overview window, then click Alarm Management.

2. Click Report/Print Alarm , then select the printer options you want and click OK.

To set the alarm state, priority, owner and Note:

There are two ways to manage alarm state, priority, and owner. One is in the Alarm Management Window, and the other is
in the Batch Alarm Management Window, which is opened directly from the alarm event in the Alarm Overview window.

* In the Alarm Detail window
1. Right-click on any alarm event in the Alarm Overview window, then click Alarm Management.

2. Inthe Alarm Status area, select the State, Priority, owner and Note from the drop-down lists. If you want to
reset these options to the settings when you opened the window, click Reset.

3. Click Update to manage this alarm.

* In the Batch Alarm Management window: Batch Alarm Monagement

Status: MNew -

Friority: Critical -
Cwner: admin -

Note:

1. Right-click on any alarm event in the Alarm Overview window, then click
Batch Alarm Management.

2. Inthe Batch Alarm Management window, select the State, Priority, owner
and Note from the drop-down lists. Click OK.
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Exporting Alarm Data to an Excel File

Alarm data can be exported to an Excel file. You can do this for a single selected alarm, or for all alarms in the Alarm

Overview window. The columns in the exported file are including AlarmName, Priority, State, EventType, SourceDevice,
Owner, AlarmTime.

=1 Microsoft Excol - CHs
] BREO REER RO BAD #7500 IED BNOD RS HEE  Adoh FIF

FARERAETHIME
N EE RS RTE %GB S B F ] B I00% - @) S Sane Serid S B ruU|lSE=E=G8 [ HEE- by
Al - £ ‘'AlarmMName
A I B I C I D I E I F I G I H I
[ s Name Priority State EveniTyne SourceSener Sourcelevice Dwner AlarmTime
2 |General Motian Critical MNew General Motion NULIO Camera 3 admin 2008-03-15 21:14.00
General Mation Critical MNew General Motion NUUO Camera 3 admin 2008-03-15 21:13:87
General Motion Critical Mew General Motion NUUO Camera 2 admin 2008-03-15 21:13:50
6 |General Motion Critical Mew Genetal Motion NUUO Camera 3 adrnin 2008-03-15 21:13:47

To export a single alarm event to Excel:

Right-click on any alarm event in the Alarm Overview window, then click Export Selected to Excel.

To export all alarm events in the Alarm Overview window to Excel:

Right-click on any alarm event in the Alarm Overview window, then click Export All to Excel.
Clearing Alarms
All alarm events can be cleared from the Alarm Overview window.

To clear all alarm events:

Right-click on any alarm event in the Alarm Overview window, and then click Clear All.

Page - 69



Map Window

Map Window

Adjusting Map Appearance

The display of map graphics in the Map window can be controlled. The size of the map can be selected, and the map
moved in the window to show the required area. The brightness of the map graphic can also be changed without affecting
the brightness of device indicators on the map.

To control the size of a map:

Use the zoom in 2 / zoom out 2 buttons or with the mouse wheel to adjust map size, or click the magnify /2 button and
select one of the following options:

* Full Size
* FitImage
¢ Fit Width
*  Fit Height
To enable area zoom:
Click the magnify 42 button and then select Area Zoom. Click and drag with your mouse to draw a rectangle on the map.

This area will be magnified to fit the screen. Click again to turn Area Zoom off.

When Area Zoom is enabled, click on the map to center it. Drag the minimized icon on the lower right corner to move the
map around.

To lock the map size:

Click the magnify »~ button and then select Zoom Lock. This prevents the accidental changing of the map size. To turn
Zoom Lock off, click it again.

To pan when the map size is larger than the Map window:
Click and drag the map to the position you want.
To lock the map pan setting:

Click the magnify & button and then select Pan Lock. This prevents accidental panning of the map. To turn Pan Lock off,
click it again.

Q The controls above can also be accessed on the Zoom menu.

To adjust map brightness:

Move the brightness slider J for the brightness you want.

Navigating Between Map and Servers/ Devices

It is easy to navigate between different layers of maps, and to show the maps for devices in various locations. There are
two ways of doing this: clicking icons in MapView, and using indicators on the map.

To navigate in MapView:

Ensure that the MapView window is selected. Then either:

«  Click the icon B for the map you want to display.

or
¢  Click a device icon. The map which the device indicator is on will display.
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To navigate with indicators:

Ensure that the MapView window is selected. Then click on a map indicator to see the underlying (child) map. Click

the Go to Parent Map button & to go to the parent map.

Searching for devices on the server list or on map
Users can search for devices, servers or map indicators on the server list or on maps by using the Search function.
To use the search function:

1. On the Search toolbar, click the Search icon 43

~ Search

Find what:

JPL

I~ Match case

[ Match whole ward anly

Find ¥Where: Find String In

" MapTree v Server|P

f+ ServerTree Iv¥ Server State
Device [v Server Address
r Iv Server City

Iv ServerGroup ¥ SemerZIP

Il By I~ Contact Name
£ it I~ Contact Phane
v 10

I~ Contact Email
v Metadata

’ Find Previous ] ’ Find Mext ]

2. Inthe Search window, enter the full name or part of the name of the indicator you want to search for.

3. Select from the following options:
* Match case - searches for names where the case matches the letters you entered.

¢ Match whole word only — searches for the term you entered as a whole word. If the term you entered forms
only part of an indicator’'s name, that indicator will not be found.

* Device — check to select which kinds of devices you want to include in the search.

*  Find Where — MapTree / ServerTree — Click to define search range, either from the MapTree or ServerTree.
* Fing String In — Specify string location for more accurate results.

4. Click Find Next to search for the indicator name. If an indicator is found, the map it is on will be displayed and the
indicator will be highlighted. The corresponding icon in the MapView window will also be highlighted.

5. If you want to search through multiple indicator names which include the same term, click Find Next until the
indicator you want is found. Click Find Previous to go back to the previous found indicator.

Q You can also search for indicators by entering a string in the Search box and pressing Enter.

Map Indicators

Indicators on a map provide a graphical representation of the connection and alarm states of the devices or servers they

represent, or for map indicators the alarm state of devices on their child maps. The meaning of the various graphics is
given below.

@. Camera is connected and has no alarm
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Camera is disconnected and has no alarm

Camera is connected and has New alarm

Camera is connected and has Assigned, In Progress or Later alarm

Server is connected and has no alarm

Server is disconnected and has no alarm

Server is connected and has New alarm

Server is connected and has Assigned, In Progress or Later alarm

POS is connected and has no alarm

POS is disconnected and has no alarm

POS is connected and has New alarm

} POS is connected and has Assigned, In Progress or Later alarm
[!t Access Control is connected and has no alarm

L‘; Access Control is disconnected and has no alarm
Lf Access Control is connected and has New alarm

L&’ Access Control is connected and has Assigned, In Progress or Later alarm
— License Plate Recognition is connected and has no alarm

License Plate Recognition is disconnected and has no alarm

License Plate Recognition is connected and has New alarm

E;Q License Plate Recognition is connected and has Assigned, In Progress or Later alarm

sy L

e Input device is connected and has no alarm
N b

ST < L

¢ Input device is disconnected and has no alarm
LA
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i
& Input device is triggered and has no alarm
j:@ Input device is triggered and has New alarm

;@ Input device is triggered and has Assigned, In Progress or Later alarm
J‘F/ Output device is connected but not triggered
x Output device is disconnected

{ ) Output device is connected and triggered

8 There is no alarm on underlying map

f_,? There are New alarms on underlying map

{JQ There are Assigned, In Progress or Later alarms on underlying map

Map Display Settings
You can control the appearance of text which accompanies device indicators, and the information it shows.

To change the map display settings:

In the Edit Menu, click Map Display Setting, and choose the desired configuration:

* For text displayed above device indicators, select the font, font size, font color and any font effects desired.
* |If you want the server name displayed alongside the device name, select Show Server Name.

*  Select the background color, background transparency and camera coverage color for device indicator text.

Map Display Setting B El
Text on Map
Font = Arial -
o ]
coor ]

[ Bl [ male [ Undertine

[~ Show Servar Name

— Tant

Transparency: ——r— 160
Colar: [
Indicatar

Covarags Transpaency —— 180
Coverage Color e ~

Selected Indlcator Calor, V=1 ~]

Indlicatar Tip Delay Time: 05 -

Miscellaneous

MapView Backoround Colar. [ v

Temperature Format. @ Celsius

" Fahranheit

v 0K X Cancel
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When a user right-clicks on a device indicator on a map, or on a device’s icon in the System Control window, a Device
Alarm menu is shown.

There are some commands which are common functions to all device alarm menus. These are:

¢ View Latest Open Alarm — shows the latest open alarm (alarm with New status) for the device.
¢  Query Alarm - displays open alarms (alarms with New status), or alarms for any particular date, for the device

¢ System Information — gives information about the server.
In addition, the Device Alarm menu shows different options depending on what kind of device you right-click on.

For a camera, the menu shows the following options:

e Open Live Video Window — opens a window with live video feed from the

camera.
View Latest Open Alarm

*  Open Playback Window — opens a recorded video playback window. g ey iaT

Open Live Video Window
Open Playback Windaw
Backup Recorded Video

* Backup Recorded Video - saves a backup of recorded video from the device, Barkis
in the directory you specify. System Information

For a metadata device, the menu shows the following options:

* Metadata Search — searches metadata transaction by date, time and keyword

View Latest Open Alarm

* Open Live Video Window — opens a window with live video feed from the Quary alar
associated camera. Metadata Search

Open Live Video Window
. . . Open Playback Window
¢ Open Playback Window — opens a recorded video playback window. Backup Recorded Video
System Infomation

* Backup Recorded Video — saves a backup of recorded video from the device,
in the directory you specify.

) . . Force Output
For an output device, the menu shows the following option: Q System Information
* Force Output — triggers a digital output device such as an audible alarm signal.

For a server, the menu shows the following options:

* Open Remote Desktop — opens a remote desktop for the server.

(000

View Latest Oepn Alarm
Query Alarm
. . —— 5 Infol i
«  Backup Record Video — saves a backup of recorded video from any or all of e
. . . ki d Vid
the cameras on the server, in the directory you specify. Bockup Resord Vi

Q The same menu is available by right clicking on icons of cameras / metadata devices / 10 devices /
recording servers under Operate Mode.

»
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Common Functions

The View Latest Open Alarm, Query Alarm, and System Information commands are common to all device alarm menus.

To view the latest open alarm for a device:
1. Right-click on the indicator for the device, or on the device’s icon in the MapView display.

2. Click View Latest Open Alarm.
3. The Alarm Detail Window for the latest alarm opens. For information on this window, see page 64.
To query alarms for a device:
1. Right-click on the indicator for the device, or on the device’s icon in the MapView display.
2. Point to Query Alarm, then choose which alarms you want to see:
e Open - shows all open alarms.
* Today - shows alarms from the current day.

e Custom - specify a range on date and time, then click OK.

System administrators set the length of time that alarms are stored on the server (see page 42). If you
choose a date for which alarm information is not stored, the No alarm found on the device message is

displayed.
3. The query results are displayed in the Output/Output 2 tab. For information on this window, see page 63.

To show information about the server:
1. Right-click on the indicator for the device, or on the device’s icon in the MapView display.

2. Click System Information.

NUUO - 192.168.1.92
General
Device Status | Alarm
(Lo it D % Camera 1 v No Slarm
Time Zane GMT+08:00 2 Camera 2 v o Alarm
® Camera 3 1" @ New Alarm
<7 Camera LInput 0 = No larm
Recording Information </ Camera 1-Input 1 = Mo Alarm
. &/ Camera L-Input 2 = Mo Alarm
Recording Schedule: Enahle 7 Camera LInpLt 3 — o alarm
Auto Recycle: Enable " Camera 1-Output O = Mo Alarm
/Camera 1-Output 1 = No Alarm
LastRi le Ti =
ERIGIEEE VT ' Camnera 1-Output 2 = Mo Alarm
Last Recycle Range: " Camera 1-Output 3 = Mo Alarm
Recording Days on Disk:
W Used Disk Spce 18.51GB
W Free Disk Spee: 18.05GB
Total: 375768
Hardware Health
CPU Temperature: A
Fan Speed: A
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Camera Alarm Menu

The Open Live Video Window, Open Playback Window, and Backup Recorded Video commands appear on the device
alarm menu for cameras. The first two options are the same as on the Alarm detail Window (see pages 64-68).

To open a live video window:
1. Right-click on the indicator for the camera, or on the camera’s icon in the MapView display.

2. Click Open Live Video Window. The Live Video Window for the camera is displayed.

[E]Live Yideo Window

Source Device: Local - Vivotek FO7141 (FDT141)
Source Address 182168.1.77

Wideo Resolution 800600

Bit Rate 288 khps

Frame Rate: 2fps

3. If you want to adjust the video to original video resolution, check Adjust to original video resolution E]

4. Click Snapshot button . The snapshot is displayed and users can save the image or copy it to the clipboard.
5. Click on Alarm Management to go to the alarm management window.

6. Click on Alarm Playback to view alarm playback video if available.

7. Select Streaming profile button to choose different video quality. Options include Original/Main, Recorded,
High, Normal, Low and Minimum.

8. For cameras with two-way audio support, you may click and hold the Talk button for this function. Talking will
end when you release the button. Please note alarm live view pop-ups will be temporarily disabled when using
the Talk function.

9. If the camera is equipped with Audio function, the Audio button will appear. Click to enable audio stream.

10. If the camera is associated to metadata devices, the Metadata button will appear. Click the button to disable
metadata display.

11. Click the PTZ button for the following PTZ controls:
. Enable Digital PTZ: Check to switch between digital / physical PTZ

o Preset Point: Choose if available from the drop-down list

. Patrol or AutoPan: Choose if available from the drop-down list, click @ to start and @ to stop

o Direction controls: Up, Down, Left, Right and Home

. Zoom out (-) and zoom in (+) controls

. Focus far (-) and focus near (+) controls

. Speed Dome Menu: If supported, this button enables the Setup Menu of Speed Dome cameras.

The menu will be displayed directly on the video channel. Use the PTZ controls to navigate down
the menu. Other assigned keys with functions will be displayed on the screen, for example the
Focus button for “Select”.
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PTZ Control
[~ Enahle Digital PTZ
Preset Point

detup Menm

|--Select0ne-- j Exit...

S e
] Ry

H:;ﬂ:;:i“” Satup

@ Diognostics

Zoom E] F]

Focus E] /

’ Speed Dome Menu

o

Focus/Iris: i?lerl

* |f the camera supports ImmerVision Lens and was correctly configured in Main Console, an additional button

Switch to ImmerVision will appear above the PTZ Control panel. Click on the arrow to select between
Original / Quad Mode / PTZ Mode / Parameter Mode.

To open a recorded playback window:
1. Right-click on the indicator for the camera, or on the camera’s icon in the MapView display.
2. Point to Open Playback Window.
3. Select the period which want to display.
* Last Open Alarm- it would open one minute recording video before last open alarm.

* Custom Time- it can set Start/End time to define the period of recording video.

Custom Remote Playback

Start Time 2008/03/27 (245 FF = <

End Time: 2008/03/27 0245 FF = =

Time Zane @MNCS Client O Source Server

7o ] (X ooer |

* One Minute Before- open one minute before.
* Ten Minutes Before- open ten minutes before.
* One Hour Before- open one hour before.

4. The Remote Playback Window has full playback controls.

=] Remote Playback Window (Test Server - Streets) - Remote
Playback Mavigation @

}
[e]La](][w] (@[]
Playback Period
T 07:39:27 - T 07:40:27
Export Period
T 07:39:27 - FoF 07:40:27

5. Click Snapshot button . The snapshot is displayed and users can save the image or copy it to the clipboard.

6. Click Export Video button to save recorded video.
* Set up the cue in and cue out points; the cue in and cue out time will show on the information window.

* Click Export Video button, choose the folder where you want to save the file at, enter the file name and click
SAVE.
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10.

11.

* Set the Export Format as ASF or AVI (ASF recommend) and set the Use Profile.
» Select to export (i.e. save) the record video with Audio, OSD and metadata display, or export video only.

* Click OK to save the video.
If you want to fix the window size at the original resolution, check Fix original video resolution E]
If the camera is equipped with Audio function, the Audio button will appear. Click to enable audio stream.

If the camera is associated to metadata devices, the Metadata button will appear. Click the button to disable
metadata display.

Click on the Digital PTZ button to enable Digital PTZ. Zoom in and out with your mouse wheel and drag to
Pan / Tilt.

If the camera supports ImmerVision Lens and was correctly configured in Main Console, the Switch to

ImmerVision button will appear. Click on the arrow to select between Original / Quad Mode / PTZ Mode
| Parameter Mode.

To Backup recorded video:

1.
2.

N o o &

Right-click on the indicator for the camera, or on the camera’s icon in the MapView display.
Click Backup recorded video.

In the Remote Backup Recorded Video window, choose a directory for the backup by pressing the URL button
and browsing to the directory you want.

Setup the Time Zone and use setting Start/End Time to select a period.
Use the checkboxes to select which cameras to back up video for.
Check Backup Metadata Transaction to include metadata information in the backup.

Click on OK to start backup.

Remote Backup Recorded Yideo
Directory where the backup files will be created:
5w
Start Time 2011056 11:2247 BF 2
End Time 201105116 11:22:47 b4 7
Time Zone * NCS Client (" Source Server
Camera
Carmnera Marne Camera Model  |[#
O vivotek IPT161 IP7161
Ovivotek FOT141 FD7141
O.pn SNC-RK530
Ovo IP7133
O SMC-CM120
O 5treets SNC-RZE0
O ofiice WV-NP502
O Immerision
[0 Gamera Ccclusion
M inting s
< *
[ Backup Metadata Transaction

To Set up Stream Profile:

1.
2.
3.

Right-click on the indicator for the camera, or on the camera’s icon in the MapView display.

Click Stream Profile.

In the Stream Profile Panel, choose Recorded, Original, High, Normal, Low or Minimum for the stream
profile to change video format, frame rate, resolution, quality and bitrate.

Click Apply to set up.

If you want to apply the Stream Profile setting to other cameras, click Apply to to set up another device.
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Stream Profile Panel

~Transcoding

Streamprofile Qriginal =
Recarded

Wideo Format: Original
High

Frame Rate: Marmal
Lowr

Resolution: Minirmurm

Guality:

BitRate:

Apply Apply to...

Metadata Alarm Menu

The Metadata Search, Open Live Video Window, Open Playback Window, and Backup Recorded Video commands
appear on the device alarm menu for Metadata devices. The steps are the same as on the Camera Alarm Menu (see
pages 76).

Wiews Latest Open Alarm
Query Alarm »

Metadata Search

Cpen Live Video Window
Open Playback Window »
Backup Recorded Video

System Infornation

To search metadata transaction:

1. Right-click on a metadata indicator, or on any metadata icon in the MapView display.

2. Click Metadata Search. Metadata Search Dialog will display.
3. Check metadata devices from the device list.
4. Configure the starting and ending time and dates.
5. Enter keyword to search metadata transaction. Check Search within result to filter the result.
6. Choose a result to display metadata transaction and video from associated camera.
Metadata Search Dialog
= B ServerGroup —Date Time Period Search
- [F]= Test Server Start Time: |201m 62 = |i¢12:uu:uuj‘ Keyword |
--[F49g TestPOS
4R TestPOS End Time: |2m11 B/ 2 :l |'F¢ nz:zs:aaj I™ Search within result
03 TestAccess Control

g TestPOS
D% TestLPR Date Time ‘ Hource Server | Metadats Channel | Metadata
B Soced Dame 20110519 14:35:54  Test Server Test POS Za 2011-05-19(79)
--00% sp 2011/05/19 14:35:57  Test Server Test POS Bis 2011-05-19(79)
g post 20110519 143600 Test Server Test POS B 3011-05-19(79)
Osig vos? 20110519 143603 Test Sexver Test POS Bk 3011-05-19(79)
2011/05/19 14:36:06  Test Server Test POS ix 2011-05-19(79)
Oig a1 20110519 143609 Test Server Test POS B 2011-05-19¢79)
2011/05/19 14:36:12  Test Server Test POS s 2011-05-19(79)
20110519 14:36:15  Test Server Test POS B 3011-05-19(75)
20110519 14:36:18  Test Server Test POS Bk 2011-05-19(79)
20110519 14:3621  Test Server Test POS BiE 011-05-19(75)
TS 14250 Tad Merver Test PO a5 P EICS )]
0110519 143837 Test Server Teat FUS Bz 301 1-05-19¢F9)
20110519 14:26:30  Test Server Test POS B 3011-05-19(75)
T 2011-05-19(F9) 14:36:24
co1 MC#01 003630
=1
1 APPLE JUICE $a9
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To open a live video window:
1. Right-click on the metadata indicator, or on the metadata icon in the MapView display.

2. Click Open Live Video Window. The Live Video Window for the metadata device is displayed.

2 Live Uideo Window

Soutcs Deviee. 192168174
Saurce Address:  192.1681.74
Videa Resoluion; 704 %480
BitRate. 249 Kope
Frame Rate: 21ps

3. If you want to adjust the video to the original video resolution, check Adjust to original video resolution.
4. Click Snapshot button . The snapshot is displayed and users can save the image or copy it to the clipboard.

5. Select Streaming profile button to choose different video quality. Options include Original/Main, Recorded,
High, Normal, Low and Minimum.

6. If the camera is equipped with Audio function, the Audio button will appear. Click to enable audio stream.
7. Click the button to disable metadata display.

8. Click the PTZ button for the following PTZ controls:
. Enable Digital PTZ: Check to switch between digital / physical PTZ

J Preset Point: Choose if available from the drop-down list

. Patrol or AutoPan: Choose if available from the drop-down list, click @ to start and E] to stop
o Direction controls: Up, Down, Left, Right and Home

. Zoom out (-) and zoom in (+) controls

. Focus far (-) and focus near (+) controls

. Speed Dome Menu: If supported, this button enables the Setup Menu of Speed Dome cameras.

The menu will be displayed directly on the video channel. Use the PTZ controls to navigate down
the menu. Other assigned keys with functions will be displayed on the screen, for example the
Focus button for “Select”.

PTZ Control
[~ Enahle Digital PTZ
Preset Point

detup Nenu

|-Gelect One-- - Exit...

Patral A @ w
@ E}iprllg':“;t!up
@@ l[!::;ﬂ:;;atmﬂ intup
@ Dingnostics
Zoom E]
Focus E]

Speed Dome Menu

!

y

Focus/Iris: i?lerl
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If the camera supports ImmerVision Lens and was correctly configured in Main Console, an additional button

Switch to ImmerVision will appear above the PTZ Control panel. Click on the arrow to select between
Original / Quad Mode / PTZ Mode / Parameter Mode.

To open a recorded playback window:

1.
2.
3.

10.

Right-click on the metadata indicator, or on the metadata icon in the MapView display.
Point to Open Playback Window.

Select the period you want to display.

* Last Open Alarm- this opens one minute of recording video before the last open alarm.

* Custom Time- this sets the Start/End time to define the period of recording video.

Custom Remote Playback

Start Time 2008/03/27 (245 FF = =

End Time: 2008/03/27 0245 FF = =

Time Zane @MNCS Client O Source Server

v o ] (X o]

* One Minute Before- open one minute before.
* Ten Minutes Before- open ten minutes before.
* One Hour Before- open one hour before.

The Remote Playback Window has full playback controls.

[E] Remote Playback Window (Test Server - Streets) - Remote

Playback Mavigation

}
[e]La](][w] (@[]
Playback Period
T 07:39:27 - T 07:40:27
Export Period
T 07:39:27 - FoF 07:40:27

Click Snapshot button . The snapshot is displayed and users can save the image or copy it to the clipboard.

Click Export Video button to save recorded video.
* Set up the cue in and cue out points; the cue in and cue out time will show on the information window.

* Click Export Video button, choose the folder where you want to save the file at, enter the file name and click
SAVE.

» Set the Export Format as ASF or AVI (ASF recommend) and set the Use Profile.
» Select to export (i.e. save) the record video with Audio, OSD and metadata display, or export video only.

* Click OK to save the video.
If you want to fix the window size at the original resolution, check Fix original video resolution E]
If the camera is equipped with Audio function, the Audio button will appear. Click to enable audio stream.

If the camera is associated to metadata devices, the Metadata button will appear. Click the button to disable
metadata display.

Click on the Digital PTZ button to enable Digital PTZ. Zoom in and out with your mouse wheel and drag to
Pan / Tilt.
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11. If the camera supports ImmerVision Lens and was correctly configured in Main Console, the Switch to

ImmerVision button will appear. Click on the arrow to select between Original / Quad Mode / PTZ Mode
| Parameter Mode.

To backup recorded video:
1. Right-click on the metadata indicator, or on the metadata icon in the MapView display.
2. Click Backup recorded video.
3. Inthe Remote Backup Recorded Video window, choose a directory for the backup by pressing the URL button
and browsing to the directory you want.
4. Setup the Time Zone and use setting Start/End Time to select a period.
5. Use the checkboxes to select which cameras to back up video for.

6. Click on OK to start backup.

Remote Backup Recorded Video

Directory where the backup files will be created.

|
Start Time 2008/0316 0626 FF = =

End Time: 2008/03/16 06:26 FF 1= =

Time Zone: (@ MNCE Client () Source Server
Camera:

Camera Name Camera Model
[ Camera 1 AYS100

[ camera 2 2y3130

[ Camera 3 1Qeyes1l

X Cancel

Output Device Alarm Menu

The Force Output command appears on the device alarm menu for output devices.

To force output:
1. Right-click on the indicator for the output device, or on the output device’s icon in the MapView display.

2. Click Force Output. A signal is sent to trigger the output device.

Server Alarm Menu

The Backup Record Video and Open Remote Desktop commands appear on the device alarm menu for servers.

To back up recorded video:
1. Right-click on the indicator for the server, or on the server’s icon in the MapView display.
2. Click Backup recorded video.
3. Inthe Remote Backup Recorded Video window, choose a directory for the backup by pressing the URL button
and browsing to the directory you want.
4. Setup the Time Zone and use setting Start/End Time to select a period.
5. Use the checkboxes to select which cameras to back up video for.
6. Click on OK to start backup.
To open a remote desktop for the server:
1. Ensure that the source server has enabled the Remote Desktop network server.
2. Right-click on the indicator for the server, or on the server’s icon in the MapView display.

3. Click Open Remote Desktop.
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Advance Alarm Search

The Advance Alarm Search window provides a comprehensive set of filters to search for alarm events. The results can be
displayed either in the Output window or the Output 2 window.

To use Advance Alarm Search:
4. Inthe Tools menu, click Advance Alarm Search.

5. Inthe Advance Alarm Search Dialog window, check the box or boxes for the search criteria you want, then
choose the desired options (if no options are selected for a given field, it means search for all).

Advance Alarm Search Dialog
Genﬁ@!_______________= v Source Device |w EventMessage
I Alarm Name;
|Alarm ane j =-[JC0 SenerGroup | |JCT General Motion e
--O0= Local [0 Foreign Ohject
I Owiner Mame = Sureeillance Server [0 Missing Object
admin - O & GARoom [0 Focus Lost
[ Aarrn State O 2 Dema [0 Camera Occlusion
O * Taipei Strests (0 Camera Signal Lost
|ODE” j |A” j O & Awil Lavigne 17 Disk Space Exhausted
v Alarm Priority a 2 Ayumi Hamasaki DD Systern Health Unusual
[ Greater than |H\gh j 0O 2 Artemis [0 System Resource Failure
O & Office [0 Systern Metwork Abnormal
B TR (D D;/ Arternis-Input 3 DD Digital Input Triggered
- Clyde [ Transaction Start
O Sureeillance Server [0 Transaction End

Date / Time
O * Camerat (7 Open Cash Drawer

M (EEi I~ E O ® Ccamera2 [0 Connection Lost
W From = O * Camera3 [0 User defined 1
O ® Camera4 [0 User defined 2
v To: ’—4| ,7_ [ * Truen-TCAM series (230(,,] |[JCJ Userdefined 3
< = Y [0 User defined 4 M

Add Filter Criterion ]

Alarm Mame | Owner Name | Status Priotity | Alarm Mote | Start DateTime | End DateTime | Source Devi.. | Event Message

[ Outputto Pane 2

ot s

6. Setup the General options for criteria:
* Alarm Name - choose a name from the drop-down list.
* Owner Name — choose a name from the drop-down list.
* Alarm State — choosing Open or Close in the first list reveals different states in the second list:
Open — All, New, Assigned, In Progress, or Later in the second list.
Close — All, Close, Auto Close, or Ignore in the second list.
* Alarm Priority — click the button to cycle through Greater than, Equal to, and Less than. In the drop-down list, select a
priority.
* Alarm Note — enter keyword for search
7. Setup the Date/Time for search:

* Date/Time — check Date and/or Time; and From and/or To, in the checkboxes. Then choose the date/s and time/s you

want.
To setup one day as the search period, click on the Flicon next to Time  con e L
-;@: and select 1 day. Or manual enable and set date from 2008/3/16 [ Fror: o
' to 2008/3/17.
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8.

10.

11.

12.

13.

Choose the Source Device and Event Message.

* Source Device — check the box or boxes for the devices you want to search. If only check the Source Device without
select any devices from tab, the criteria would search for all devices.

* Event Message — check the box or boxes for the event messages you want to search. If only check the Event
Message box without select any events from tab, the criteria would search for all events.

Click Add Filter Criterion. The search criteria you selected appear in the window.
You can edit or remove the set of search criteria you have just created, or add another set of search criteria:

* To edit a set of search criteria, select that set, choose filter options as described above, then click Update Filter
Criterion.

* To remove a set of search criteria, select that set, then click Delete Filter Criterion.

* To add another set of search criteria, choose filter options as described above, then click Add Filter Criterion, the
search result would include each combination of all criteria.

By default, search results are displayed in the Output window. If you want the results to be displayed in the
Output 2 window, check Output to Pane 2.

To customize desired output fields in the Output and Output2 windows, click Edit Fields. For details on Edit
Fields please refer to page 64.

Click Search.
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Matrix View

The NCS Client provides feeds over the Internet to multiple video matrixes. Each matrix can display images from up to 64
cameras, along with text above each image including information about the camera and server. Matrixes can also be
configured to show video from a camera when an alarm event occurs. To display video on a matrix, the NCS client must be
logged in to that matrix. Once logged in, the matrix display can be configured and cameras chosen.

Matrix View Toolbar

The Matrix View Toolbar has the following buttons:

* Login/Logout matrix &, 9. —the NCS Client must be logged in to a matrix in order for most of the Matrix
Toolbar commands to be used.

* Remove camera on matrix & — when a camera icon on a matrix a is selected, clicking this button removes it.
e Reset matrix @ - this button removes all cameras from the selected matrix.

* Toggle allow show video on event ¥ —When selected, you can define matrix grids to display video from
cameras when alarms are triggered. Only available under Edit mode.

* Toggle tour 2] — Enable Camera tour when focused on Views, View Tours when focused on View Tours and
Grid Tour when focused on grids. Only available under Operate mode.

*  Open PTZ Control Panel & — this opens a window for PTZ controls. When using a camera with ImmerVision

support, another button Switch to ImmerVision will appear under the PTZ Control panel. Click to switch
between Original / Quad Mode / PTZ Mode / Parameter Mode. Only available under Operate mode.

* Goto previous view / next view i — Switch between Camera Tour views when focused on Views,
between views when focused on View Tours, or between cameras when focused on Grid Tours. Only
available under Operate mode.

e Save View Group = - this saves the current matrix view group into the View Group List. Only available under
Edit mode.

¢ The Audio button 9 _ this enables camera audio.

ral
£

e The Talk button — this enables two-way audio, or talking directly to the chosen camera.

e The Matrix grid buttons [ - ~ —these control the layout of the matrix grid.

Showing Video on a Matrix

Showing video on a matrix requires that a matrix system be executed, either on the same computer as the one running the
NCS Client, or another one. For information on how to execute a matrix system, see page 45. For the NCS Client to show
video on a matrix, it must be logged in to that matrix.

To login to a matrix:

Select the matrix you want to log in to and click the Login matrix button &

To load a matrix View Group / View / View Tour:
1. After logging in, go to the View Group List under Operate mode.
2. To load a View Group, right click on the icon and choose Load on Matrixes.

3. Toload a View or View Tour, right click on the icon on a specific view and choose Show on Matrix.
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-:Qj

Alternatively, drag View Groups, Views and View Tours from the View Group list directly into the matrix list
to load them. To do this, the NCS Client must be in Operate mode.

To configure a matrix grid layout:

1.
2.

3.

-:Qj

Ensure that the NCS Client is logged in to the matrix as described above.

Select the matrix you want to configure.

Click one of the Matrix grid buttons @ 6 = . The second button from the right |61 ~ is the

Matrix Grid NxN button. Clicking the arrow next to this displays a menu, from which you can select more display

grid options. The button on the far right [7] - Matrix Grid 16:9 is a new set of grids dedicated to wide-screen
displays.

Double click on any channel under multiple channel view to switch to a dedicated single channel view.
Double click again to switch back.

To add cameras / Grid Tours to a matrix:

1.
2.
3.

-:Qj
Q

Ensure that the NCS Client is logged in to the matrix as described above.
Select the matrix you want to configure.
Drag cameras or Grid Tours directly from the Server List, View Group List or Map to the desired matrix grid.

The camera icons appear on the matrix. You can drag them to different positions on the matrix. To see which

camera a particular icon represents, point to the icon. A text bubble appears showing the camera name, type, and
server.

Select Stream Profile of the camera. Choose As NCS Client, Original/Main, Recorded, High, Normal, Low or
Minimum.

You can disable the Link between the Map and Matrix by clicking the Disable Link between Map and

Matrix button D .

You can disable send video on event to Matrix by clicking the Disable to Matrix button &

Video of new alarm events cannot replace old events on the Matrix if the Matrix is full and users do not

close old events when you click the Disable Matrix Popup button B .

To remove a camera from a matrix:

1.
2.

3.

-:Qj

Ensure that the NCS Client is logged in to the matrix as described above.

Select the matrix you want to configure.

Select the camera icon and click the Remove camera on matrix button - .

The setting of Matrix can only save on NCS client PC. The same user account login server with different
PC can't load the original Matrix setting.

To reset matrix:

1.
2.

3.

Ensure that the NCS Client is logged in to the matrix as described above.

Select the matrix you want to configure.

Click on the arrow next to the Remove Camera on Matrix button & = and click Reset matrix.

To toggle allow show video on event:

1.
2.

Ensure that the NCS Client is logged in to the matrix as described above.

Select the matrix you want to configure.
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Click the Toggle Allow Show Video on Event button ¥ 7 or select Edit “Show On Event” Mode. Select grids
you want to show video on events. Clicking again can disable allow show video on events.

Choose Select All to toggle allow all grids show video on events.
Choose Clear All to disable allow all grids show video on events.
For advanced management, click on Setting...

You are able to define up to 16 different groups indicated with 16 different colors under Group Setting.

To toggle tour:

1.
2.

Ensure that the NCS Client is logged in to the matrix as described above.

Select the matrix you want to configure.

Click Toggle Tour button 2] .
Click Toggle Tour button again to disable tour.

Joystick Control

Matrix system can be controlled by a joystick. Prior to setup, it requires a joystick device connected to NCS Client computer.

To setup Joystick Control:

1.
2.
3.

Click the Edit button and point to Joystick Setting.

In Joystick Setting Window, select the Active Joystick you want to use.

Select the function and the parameter from drop-down menu for the button of joystick. The function are as below:
* N/A —make the button ineffective.

* Go to Preset Point — go to the preset point of the view on a matrix or a live video. Select the parameter for the preset

point.
Joystick Setting

Active Joystick: Doz |
Buttan Function Parameter A
Button 1 Goto Preset Point 1 =
Button 2 Goto Next Grid ¥

Buttan 3 Toggle Single Camera View i

Button 4 Switch Matrix Grid )

* Go to Previous Grid — go to previous grid on a matrix.

* Go to Next Grid — go to next grid on a matrix.

» Switch Matrix Grid — switch grids of a matrix.

* Toggle Single Camera View — toggle select camera to single view.
« Start/Stop Autoscan —start/stop autoscan on a matrix.

* Zoom Wide — zoom wide of the view on a matrix.

* Zoom Tele — zoom tele of the view on a matrix.

* Switch Active Matrix — switch into different matrix.

* Go to Matrix View — go to Matrix List Window.
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ojLe

Joystick Setting Joystick Setting
Active Jovetick, USBE 248K GamePad v Active Joyetick, USBE 248K GamePad ~
Button Function Parameter Button Function Parameter
Button 1 Gato Pravious View Button 1 | Gota Previous View -
Button 2 Gato Next View Button 2 T -
Button 3 Toggle Single Camera View Button 3
Button4  Switch Screen Layout Button 4 gg:g ';:zﬁu'zn\‘,?éw
Button 5 Switch Active Matrix Button S | 5otg Next View
Button &  Start/Stop Autoscan Button & |Syitch Screen Layout
Button 7 M/A Button 7 |Toggle Single Camera Wiew
Button 8 NfA Button 8 |Start/Stop Autoscan
Zoom Wide
Zoom Tele
Swiitch Active Matrb
Goto Matrixiiew
(| [ Ok ] [ % Cancel ] Default ] [ TS ] [ % Cancel ]

* Go to Server View — go to Server List Window.

* Find Recording Server — Focus to chosen Server on Server List. Must be used with number buttons.

Format: Press this button + server number + Enter
E.g. To go to server number 8, press Find Recording Server + 8 + Enter.

To display server / camera / matrix numbers, go to Edit — NCS Client Setting — Miscellaneous — Show
central ID on server list and matrix list.

* Open Live View — Open Live View window for selected camera. Must be used with number buttons.
Format: Press this button + camera number + Enter

E.g. To show live video of camera 12 from server 5, press Open Live View + 5012 + Enter.

* Open Instant Playback — Open Instant Playback for selected camera. Must be used with number buttons.
Format: Press this button + camera number + Enter

E.g. To show instant playback of camera 6 from server 3, press Open Instant Playback + 3006 + Enter.

* Show Camera to Matrix — Show selected channel of camera on selected grid of matrix.

Format: Press this button + camera number + Enter + matrix and grid number + Enter.
E.g. To show live video of camera 3 from server 5, to grid 11 of matrix 15, press Show Camera to Matrix
+ 5003 + Enter + 15011 + Enter.

* Switch Stream Profile — Press to switch between different stream profiles of Live View or matrix views.

Sequence of stream profiles: NCS Client — Original — Recorded — High — Normal — Low — Minimum

» Take Snapshot — Press to take a snapshot of current Live View or Playback window.
* Play Playback — Press to play Playback.

* Pause Playback — Press to Pause Playback.

* Stop Playback — Press to Stop Playback.

* Numbers 0~9 — Assign numbers to input server / camera / matrix numbers.

¢ Enter — Confirm commands.
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Log Viewer

The Central System Log Viewer can be accessed from the Tools menu. You are able to search and export a checklist of
events according to source device and time/date.

|E| HCS Client [asdmin] [Trial]
i File Edit WView  Took  Zoom Help
i [PEdit Mode = |

Server Summary...

To Search and Export log information:

Serwer List Central Server Information
£ ServerGronp ‘ Central System Log Viewer
=& Local
3 04 Roa Advance Alarm Search...
2 Demo Real-time Alarm Filter I3
® Taipei® —
2 LvrlLa Central Backup
2 Lymil Central Backup Status
2 Artemis =
2 Office Remote Flayback
= Clyde 2 N
3 Camers Wideo Matrix

1. Pick a source device: NCS Server, NCS Client, Recording Server or All.

Choose from a list of log types. Default includes all available options, click again to deselect.

Click on Search. Log information will be displayed below.

2
3. Choose a Date or specify a time range under Date Time.
4
5

Click on Export to... to export searched log information to Excel files.

Log Yiewer

Systern Log ]

Source Device:

Log Type:

NCS Cliert -

Configuration Commit
Client Login

Client Login Fail
Cliert Lagout

Export Video

Backup Video

" Data A=
+ Date Tirne: 2010M 101 00:00 = 5
to 2010111104 15:28 7 &
Exportto... ] i Search |

Log Time

2010/11f01 17:25:37
2010/11f01 17:29:32
2010/11/01 17:34:30
2010/11/01 20:23:27
20101101 21:16:00
2010/11/02 11:34:48
2010/11/02 11:36:29
2010/11/03 11:52:28
2010/11f02 19:21:22

Log Type

Client Login
Configuration Commit
Configuration Cormmmit
Configuration Cormmmit
Configuration Cornmit
Configuration Cornmit
Configuration Cornmit
Configuration Cornmit
Configuration Cormmit

Status | Description

Username=admin, IP=127.0,.0.1
UserMame=admin, IP=127.0.0.1
UserMame=admin, IP=127.0.0.1
UserMame=admin, IP=127.0.0.1
UserMarme=admin, IP=127.0.0.1
UserMarme=admin, IP=127.0.0.1
UserMNarme=admin, IP=127.0.0.1
UserMNarme=admin, IP=127.0.0.1
UserMame=admin, IP=127.0.0.1
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Remote Playback Shortcut

The Remote Playback command in the Tools menu displays a NUUO NVR/NDVR/DVR control screen from the server.
For information about the NUUO NVR/NDVR/DVR software, see its accompanying documentation.

To execute the Remote Playback shortcut:
6. Inthe Tools menu, click Remote Playback.

7. For multiple monitor systems, select which monitor you want the NVR/NDVR/DVR control screen to display on.

Monitor Selection Dialog
Wanitor Resalution
# 1280 % 800
#2 1920%1200

8. Click OK.
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Server Summary

The Server Summary window displays summary information about all the source servers connected to the NCS Client.

Server Summary

Finish to Update

Hame Login | Recording | Free... | Camera.. | VO Count | POS Count | AC Count | LPR Count | Time Zone

E[)5erverGroup
& Test Server admin  Stopped B6.53GB  16{16) 86T T 0im oim GMT+08:00

< 3

License Status: Trial (29 days remaining)

License Type Camera [1je] POS AC LFR
Total License 48 g 2 2 2
Remaining License 32 0 1 2 2

This information consists of:

* Login - the login name for the recording server.

* Recording — the video recording status of the recording server.

* Free Disk Space — remaining recording server disk space.

e Camera Count — the number of camera licenses connected to the recording server.

* 1/O Count —the number of input and output devices connected to the recording server.

¢ POS Count —the number of POS devices connected to the recording server.

* AC Count —the number of access control devices connected to the recording server.

* LPR Count —the number of license plate recognition devices connected to the recording server.

* Time Zone - the time zone of the recording server.

* License Status - the license status of the NSC system

* Total License — the total number of licenses, including cameras, metadata and I/O devices.

* Remaining License - the remaining number of licenses, including cameras, metadata and 1/0O devices.
To use the Server Summary window:

1. Inthe Tools menu, click Server Summary.

2. Usethe [ and = buttons beside the server group folders to view server information.

3. To refresh the information in the window, click Refresh. This refreshes Login User, Recording status and Free
Disk Space. To refresh number of cameras, 10, and Time Zone, select Synchronize Device while in Edit Mode.

To open a window with more detailed server information:

In the Server Summary window, select a server, then click Detail.
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NCS Client Software version

To view the NCS Client software version:
In the Standard Toolbar, click & to see version information. Alternatively, in the Help menu, select About Central.

About NCS Client
NCS Client Version 1.5.0
Copyright () 2004 10
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Cross Time Zone Scenario

The NCS System is easy to use across multiple time zones. The NCS Server and the SQL database record all alarm times
in UTC (Coordinated Universal Time). This enables the NCS Server to put the alarms in order before they are sent to the
NCS Client. The NCS Client converts the alarm times to the local time, to enable users to manage alarms efficiently.

If required, NCS Client users can access source devices’ local times in the Alarm Detail window and the Alarm Overview
window (see Alarm Log Settings on page 64).

Main Console

BRAZIL | Tokyo | LOS ANGELES
UTC/GMT- UTC/GMT+08:00 UTCAGMT-
" 0200 - AM11:13 -~ fg:00
) AM00:13 ? ? PM06:13
Aarm | | Alarm i Aarm
L RECTEEET Convert to UTC O
Time
AM 02:13
SQL DB ¥ NCS Server

UTC Time [ " 5 UTCTime
AM 02:13 w . w AM02:13
— =

Convert to Local Time

NCS Client

TAWAN
UTC/GMT+08:00
S | AMA10:13
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